Fast Track to Windows VISTA
TIPS, TRICKS and SECRETS

YOUR HANDY GUIDE TO EVERYDAY TECHNOLOGY
Fast Track to
Windows Vista:
Tips, Tricks and Secrets
Credits

The People Behind This Book

Robert Sovereign-Smith Editor

DESIGN AND LAYOUT
Vijay Padaya, U Ravindranadhan Layout Design
Rohit Chandwaskar Cover Design

CONTENT
© 2008 Incisive Media.
All rights reserved.
Published from “The Ultimate Guide To” with the permission of Incisive Media
Reproduction in any manner in any language in whole or in part without prior written permission
is prohibited

© 9.9 Interactive Pvt. Ltd.
Published by 9.9 Interactive
No part of this book may be reproduced, stored in a retrieval system or transmitted in
any form or by any means without the prior written permission of the publisher.

December 2008
Free with Digit. Not to be sold separately. If you have paid separately for this book,
please e-mail the editor at editor@thinkdigit.com along with details of location of
purchase, for appropriate action.
CONTENTS

Chapter 1  Delve Deeper Into Vista  05
Chapter 2  25 things you didn’t know about  Windows Vista  12
Chapter 3  Making a difference  20
Chapter 4  Hidden talents  26
Chapter 5  Control Vista with your voice  34
Chapter 6  Discover handwriting recognition  37
Chapter 7  Making the most of Windows Calendar  40
Chapter 8  Back up important files and folders  43
Chapter 9  Protect kids with parental controls  46
Chapter 10  Windows DVD burning secrets  49
Chapter 11  Get up-to-date news from Internet Explorer  52
Chapter 12  Get mobile with Sync Center  55
Chapter 13  Discover Windows Sideshow  58
Chapter 14  Share your files with Meeting Space  61
Chapter 15  Instantly improve your PC’s performance  64
Chapter 16  Have fun with Vista’s built-in games  67
Chapter 17  Customising Vista  70
Chapter 18  Master Vista’s Control Panel  78
Chapter 19  Tricks for better performance  85
Chapter 20  Searching and indexing tips  88
Chapter 21  Master Vista’s keyboard shortcuts  91
Chapter 22  Learn the secrets of Command Prompt  94
Chapter 23  Optimise your laptop with Mobility Center  98
Chapter 24  Getting more from Sidebar Gadgets  101
Chapter 25  Tweak Vista with Tuneup Utilities 2007  104
Chapter 26  Preventative medicine  108
Chapter 27  Repairing a corrupt Vista installation  114
Chapter 28  Clever ways to cure compatibility ills  118
Chapter 29  Solve compatibility woes with Virtual PC  122
Chapter 30  Fix wireless network connection problems  126
Chapter 31  Tips and tactics for tighter security  130
Chapter 32  Make Vista even better  134
Chapter 33  Further Vista tips and secrets  143
Chapter 34  On the disc  149
If you have bought a PC at any point over the past 18 months, it’s likely you have already experienced Windows Vista. It’s the operating system (OS) that comes installed on most new PCs (and has also been available as an upgrade) since January last year. That might make it sound like old news, but since the lifespan of Microsoft’s previous OS — Windows XP — covered more than six years (and counting), Vista is still very much the new kid in town.

Now that the initial fuss has died down, however, it’s plain to see that, while Vista is, on the surface, disarmingly simple to use, it still has plenty of surprises up its sleeve. In addition to the software’s well-documented selling points, there are many, many more features to uncover, including entire alternative methods to control your PC, help solving technical problems, and a virtually limitless number of ways to tweak or combine various settings in order to get your computer to look, sound and act the way you want it to.

Over the next 150 or so pages, we’ll be uncovering many of these lesser-known features and functions, revealing things you may not even have known your PC could do. We’ll also be examining the hidden flaws that lurk within Windows and demonstrating how, with the help of our cover CD, you can plug some of the gaping holes left in the OS.

But before we do any of that, it’s important to establish the basics. And to do that we need to go right back to the beginning.
World domination

Today, Windows is the worldwide dominant OS. According to estimates, roughly nine out of 10 computers have a version of Windows installed on them. There are other operating systems in existence — Mac OSX and Linux to name a few, — though no other OS enjoys anything like the success of Microsoft’s software. But what exactly is an OS and why do we need one in the first place?

The answer is simple. For your PC to work, it is necessary to have some software that ties together all the various hardware components inside your computer (and out). The OS also provides a user interface of some kind, so that it’s possible for people to find your way around, run applications and edit files.

Windows first started appearing on computer screens in 1985. Its name described the way in which the then revolutionary graphical user interface (or GUI) presented window-like panes in which you could organise and navigate your programs and files. We take that for granted these days, but before Windows 1.0, most operating systems simply provided you with a blank screen and a command prompt.

With the launch of Windows 3.1 in 1992, Microsoft coalesced many of its ideas into an OS that is easily identifiable as the foundation stone for the Windows we know and use today. By that stage, Windows was already developing into something more than just a straightforward OS, providing a suite of useful software tools as part of the package. Windows 3.1 came with a File Manager for browsing files and folders, as well as an early version of the Windows Control Panel for customising settings and a modest collection of built-in mini-applications and utilities, including a text editor, a clock, a Print Manager and some familiar games — specifically Minesweeper and Solitaire.

Full of features

As Windows grew, it expanded on a range of built-in applications — known by many as applets. By the time Windows 95 came on the scene three years later, it was positively bristling with extra features and handy tools. It was in Windows 95 that we first saw the Start button and Start Menu, for example — something relatively small but significant enough to remain a central part of Windows right up to Vista. Also included were Windows Explorer, a Search function, networking features, a media player, a sound recorder and a fully customisable desktop, all of which can still be found in Windows today.

Over the years, subsequent Windows releases have brought with them even more features. Windows 98 introduced USB support. Windows ME came with a broader range of internet and multimedia tools, including the video-editing application Windows Movie Maker. In 2001, Windows XP provided the biggest revamp of Microsoft’s OS till date. It was built using a completely different architecture to previous consumer editions of Windows and featured a radically overhauled graphical interface. It also had a startling array of applets, features and options. XP’s Control Panel came with loads of tweaks and settings that allowed you to customise your experience. Its built-in Media Player was a proper grown-up music and movie program, with streaming capabilities, CD ripping and burning functions and a library-type interface.

Crucially, XP was fully internet-ready — well, almost. Its arrival happily coincided with the proliferation of home broadband connections and its built-in networking, web browsing and email functions made it easy for users to get online and make the most of what the net had to offer. However, early editions of XP were heavily criticised for their lack of security features. In order to protect their PCs against internet-borne threats such as viruses, hack-
ers, spyware and other evils, XP users were forced to turn to third-party security software.

**Customer support**

Microsoft went some way to making up for this by drip-feeding security updates and patches as free downloadable updates and by adding improved security features to XP via a downloadable Service Pack (SP2). This practice of continually adding features, functions and fixes via updates continues today and forms a large part of Microsoft’s strategy for Vista. Most of these downloads add small but important software updates to address specific security issues or bugs as they are discovered, but occasionally new or improved features are added too. Most recently, Microsoft issued the first Vista Service Pack (SP1), which brought together all the updates and patches thus far and introduced a few new features, including enhanced hibernation and file copying.

Vista was released to a mixed reception in 2007. Much of the criticism centred on Vista’s increased system requirements and problems with backwards compatibility. The truth is, however, Microsoft has never built a safer, more flexible, better looking or more feature-packed operating system than Vista.

Vista comes with almost all of the features from previous versions of Windows — most of which have been radically overhauled and are either easier to use (such as Vista’s improved networking tools), much more effective (such as Security Center) or include vastly improved performance or more options (such as Windows Movie Maker). Not only that, Microsoft has added even more extras to Vista than it did with XP. Now there’s a proper Photo Gallery, a built-in backup utility, an alternative Media Center interface — and those are just a few of the higher profile new arrivals. With Vista, the features list has spiralled out of proportion; so much so that it’s barely feasible to list each individual component that makes up the whole.

Indeed, if we were to take a critical angle for a moment, we would perhaps pick up Microsoft on the mixed messages Vista sends out. On the one hand, it’s the simplest Windows release to date, thanks to features like Instant Search which makes it easy to find anything — programs, files, settings — by typing a keyword into the Start menu search box. At the same time, it’s also the most complex and unwieldy version of Windows till date, with too many tools to take in at once and dozens of options many users may never discover.

- **Why so secret?**
  Many of Vista’s features seem to be hidden away in the depths of the operating system, but why would Microsoft intentionally make such things so hard to find? The answer is probably quite simple; unlike most software — or any other piece of technology for that matter — Windows doesn’t come with an instruction manual. And if it did, it would probably make War and Peace look like a lightweight read. In place of a ‘hard copy’ manual, Vista comes with a much improved, searchable Help and Support Center built into the Start menu. It’s very useful and comes with a selection of troubleshooting tools that can come in handy if you’re ever in a scrape. However, the plain fact is that it’s difficult to browse in the same way that a physical guide book or magazine is. But then that’s where we come in.
Windows weaknesses
That’s not Vista’s only downside, either. Despite the huge influx of features and options, there are still many areas in which Windows is curiously lacking. The most obvious oversight is Vista’s absence of built-in anti-virus protection. Other areas, such as hard disk maintenance tools and office applications, are still somewhat weak, too. On top of that, many of Vista’s much-touted cosmetic elements can slow down performance, especially on older PCs, while some peripherals and software that worked with XP may run into problems when used with Vista. In fact, with a little know-how it’s easy to plug these gaps and iron out performance and compatibility problems. We’ll be doing just that later on.

Other operating systems
There are two major alternatives to Windows; Mac OSX, available only for Apple Mac computers, and Linux, which is an open source OS available for anyone to download and install for free and comes in the shape of a number of different user interfaces – known as ‘distros’.

Both OSs easily equal Windows Vista in terms of the number of built-in features and functions. The latest version of OSX (OSX 10.5 or ‘Leopard’), for example, comes with some very handy extras, such as Time Machine (a visual backup utility) and Back to my Mac (which allows you to access your home computer over the internet). Linux distros like Ubuntu (www.ubuntu.com) go one step further. As well as including a vast number of utilities and applications from the get-go (including a full office suite), further features can be added at will – and for free –

With so many features, utilities, settings and options tucked away in every corner, it’s only natural that people coming to the OS for the first time might not initially recognise Vista’s full potential. And that’s precisely where we pick up the story. It is our aim to both uncover Windows Vista features you may not know about and show you how to get more from the features you are already familiar with. We want to make sure you maximise your possibilities and put you in charge of your PC, whether you’re exploring new avenues, getting to grips with the basics, sorting out a problem or just setting your computer up so it works the way you want it to.
Windows Vista offers a huge range of new tools, features and functions, many of which you may not have even heard about. Here’s our run down of Vista’s best kept secrets.

When Vista was launched last year, Microsoft chose a surprisingly narrow selection of new features to shout about during the promotion of the latest Windows version. In fact, there’s a lot more to Vista than you might think, and perhaps the most impressive aspect of all is the sheer number of tools that have been introduced or updated to improve the home computing experience. From protection to productivity, and communication to customisation, there are dozens of handy new features — some of which are less well advertised than others.

We provide you in-depth advice and step-by-step guides that demonstrate how to find and use many of the great lesser-known features, tools and settings included in Windows Vista. But before we get down to the fine detail, let’s take a moment to introduce some of the things you may or may not already know your PC can do.

1. Find anything, fast
Vista has completely changed the way you search for documents, programs and settings. Unlike XP’s Start menu, you don’t have to manually hunt down what you need. Just press the [Windows] key and start typing the name of what you’re looking for. As you type, Vista scours your hard disk for all files, programs and even its own settings for items that match, displaying applications at the top of the list and documents in the lower portion. The more characters you type, the more Vista filters out the results. Use it to find the features we’re talking about throughout this introduction.

2. Flip through windows
When Vista first appeared, much was made of its new look. But the appearance isn’t just skin deep — the new interface provides a handy way to browse the applications and documents open on your PC. It’s called Flip 3D and to use it just to hold down the Windows key and press Tab. Vista then displays a 3D image of all the programs you have open; pressing the Tab key again flips to the next application. This feature is not available in Vista Home Basic.

3. Print without waste
Most of us have felt at some point the need to print out a web page. In XP, printing web pages could be a frustrating experience, with ink and paper wasted as elements of the page that fell outside of a conventional A4 sheet were printed on new pages. Internet Explorer 7, which is included with Vista, has a Print Preview tool that enables you to manage how pages print. To access it, click the down arrow next to the printer icon at the top-right of the window.

4. Keep the kids in check
Enquiring minds are to be encouraged, but meddling fingers can play havoc with your settings. Children need to be protected and supervised when using your PC, and Vista can help you do this. Vista Parental Controls enable you to set specific times of the week when children can use the computer and block access to inappropriate websites and specific programs. Type ‘parental’ into the Start menu search box (see tip 1) to access the controls.

5. Record TV
With Windows Media Center, you can watch and record programs, providing you have a TV tuner built in or attached to the comput-
er. Media Center uses an EPG, much like Freeview and subscription TV services, so you can see a schedule of what’s coming up over the next seven days and plan what to watch or record. You can also access radio stations and manage your digital photo collection. Unfortunately, Home Basic users don’t have this feature.

6. Make you an icon
Vista takes a new approach to file icons — the thumbnail-size images that represent your documents. Instead of using a single picture that simply denotes which application produced the document, Vista presents an image of the document itself. Open a folder and click the view menu and you have the choice of a number of different sizes that can help you identify the file you’re looking for.

7. Protect against crashes
Everyone has experienced the frustration of losing work because their PC crashes. The reasons behind crashes are many, but Vista includes a feature called Resource Exhaustion Prevention, which alerts you when Windows is showing signs that it can’t cope, giving you the opportunity to save work quickly and even avoid the crash by closing applications.

8. Work together
If you work with other people on projects that involve a computer, then you have to take a look at Windows Meeting Space. This application lets you set up virtual ‘meetings’ over a wired or wireless networks, so that people can see documents you’re working on and exchange notes with each other. Up to nine people can take part in a Meeting Space session using Vista Home Premium or Ultimate.

9. Boost your memory
The amount of memory in your PC is one of the key elements that dictates its performance. This is of importance when you’re working in applications that use lots of memory, such as video-editing packages, or when you have a number of programs running at once. Windows Readyboost is a clever way of adding more memory as needed using USB memory keys or Flash memory cards. When you plug in such a device, Vista will give you the option to use its capacity to boost memory.

10. Shrink your programs
Gadgets are mini applications that run in the Windows Sidebar (a pane that runs down the side of the screen at all times). You can choose to display either Vista’s built-in Gadgets provided or head online for new ones. Calendars, photo viewers, news updates, performance monitors and more can be accessed from your desktop without having to launch a program.

11. Stop you getting lost
Vista includes an enhancement to the Windows Explorer navigation bar. The bar now shows not just the folder you are currently navigating but also the folders that you had to open to get there, meaning that there’s a visual trail of ‘breadcrumbs’. Each folder in the trail has an arrow next to it — click it and Explorer displays the other folders it holds, making it easier to retrace your steps.

12. Cut up your desktop
Vista’s Snipping Tool gives you total flexibility, with options to grab the entire screen, a small selection or an area you have select-
than actually controlling Windows, but it’s definitely worth checking out.

17. Take control
Vista introduces us to a feature called User Account Control. This tool makes sure that only you are permitted to make changes to settings, install programs or initiate internet access. There is an abundance of web nasties (not to mention mischievous household members) that are happy to throw a spanner in the works — User Account Control is a vital protective barrier against their wicked ways.

18. Play the game
If you like playing the occasional computer game in your free time, whether it's a flight simulator, a frantic shoot-em-up or a civilised game of solitaire, Vista brings all your games together in one place. Of interest to parents will be the ability to hide specific games by age-rating, while those who like to take on the latest 3D games can access performance-tweaking options.

19. Make a date
One thing XP users lack is a decent calendar. Vista corrects this oversight with a simple calendar that can even be shared online with family and friends. It’s a handy way for clubs and societies to keep track of activities when more than one member is organising events, and can display a choice of four views, from a single day to the full month ahead.

20. Burn a blockbuster
Vista finally includes a DVD-writing application as standard, and...
it’s simple to use. Drag and drop clips to the window and follow the step-by-step guide to add an introductive DVD menu or a soundtrack for DVD slideshows of digital images. It’s not as sophisticated as some paid-for DVD creation tools but this lack of complexity translates into simplicity for those who don’t need the bells and whistles.

21. Speed up Quicklaunch
The Quicklaunch toolbar that runs along the bottom-left side of the display in Vista is, unsurprisingly, a quick way to launch your favourite applications. If you find your mouse a bit of a bore, then Vista introduces a keyboard shortcut that gets those programs started even faster. Just hold down the Windows key and tap the number key that indicates its position on the toolbar. For example, to launch the first program from the left use the Windows key and 1.

22. Put on a Sideshow
Remember the Gadgets we discussed earlier? Well, Vista has a way of putting these to good use away from your PC. A feature called Windows Sideshow takes the Gadget and uses it to display the information it provides on a screen belonging to another device, such as the small display built into the lid of some laptops, a digital photo frame or a compatible mobile phone. So you can view the latest headlines, display your appointments or view digital photos.

23. Bolster your security
Vista includes a new Security Center that enables you to monitor and adjust security settings and updates in a single Window. Unlike XP’s version, Vista’s Security Center also shows any third-party software that is protecting your PC, instead of simply saying the computer is unprotected when Windows Firewall is not switched on. You can also manage how vital security updates are downloaded and installed.

24. Keep you in power
If you own a laptop and carry it around then you will know how important it is to keep an eye on battery life. The Vista Mobility Center brings together options for wireless connections, display brightness and power management, so you can get the most efficient use from the battery. This feature also makes it easy to synchronise data between devices such as mobile phones and the computer.

25. Recognise your scrawl
Although intended for the largely defunct tablet PC, Vista’s handwriting-recognition tools work perfectly with a touchscreen or a graphics tablet. Similar to the speech recognition tool we discussed earlier, you can use this method to control your PC and input text using a pen or stylus instead of a mouse and keyboard. It’s not included in Home Basic.
Making a difference

Not all versions of Vista are born equal - but some variations are less evident than others. We investigate the hidden features and secret tools in the different editions

Although most people think of it as a single product, the Windows Vista operating system is available in several versions. And not just one for home and one for work: there are six editions in total, each with a different selection of features and tools. Some differences are obvious, but there are hidden features tucked away inside some versions that can really help to improve the way you use your computer. We’ll explain what the different versions include, and point out the secret tools found in each one.

Basic training

Six versions of Vista sounds like a lot, but in fact there were seven official editions of Windows XP — Home, Professional, Starter Edition, Media Center Edition, Tablet PC Edition and two versions for fancy 64-bit processors. Despite this, though, most people were only ever asked to choose between two: Home and Professional. With Vista, it’s more complicated, as it’s easy to go online and buy a notebook PC with one of four different versions. Two other versions of Vista are so rare that they can be quickly discounted. Windows Vista Starter is sold at a very low cost. Its only hidden features are limitations: it can only run a handful of programs at once, doesn’t work with all processors and can’t use hard disks larger than 250GB. Vista Enterprise Edition has some interesting features and no such limitations, but it’s only sold to large businesses so you should never be offered a copy, or a PC running it, for sale.

The cheapest version of Vista that you are likely to be offered is Vista Home Basic. You can pick up a boxed copy for around approximately Rs. 8632 — and although it isn’t hobbled like Vista Starter, it too, is characterised more by what it lacks than what it includes. Most notably it can’t create DVD discs without extra software, and the backup tool can’t schedule backups to run at certain times. Aero (the name for the technology that creates fancy translucent windows and the new Flip 3D effect that appears when you press the Windows Key and Tab) is also missing from Home Basic. The only two hidden features that you might find useful are the Vista Parental Controls, which are included in full, and the Mobility Center, although this is lacking one of its most useful tools — Presentation Settings.

Premium bonds

The next step up, and the operating system included with most home computers, is Vista Home Premium. This includes everything found in Home Basic, and more besides. Unlike Basic, Home Premium can burn DVD discs and play DVD movies without the aid of any additional software. A boxed copy of Vista Home Premium can be found online for around approximately Rs. 10070.

It’s hard not to notice Windows Aero, which gives windows a semi-transparent look and enables the snazzy Flip 3D browser. Two new features that you might not spot, though, are the enhanced backup tool, which can be set to back up files according to a schedule, and the support for touchscreen control. If you are lucky enough to have a tablet PC, a touch-sensitive display or a graphics tablet, Home Premium can make the most of it.

Another obvious addition to Home Premium is Windows Media Center. This provides a simplified way to browse through and play music, videos and digital photos, and connects neatly to Windows Media Player. It also has a number of handy hidden features.
The best, is undoubtedly its electronic programme guide (EPG). Add a TV tuner to your PC, and Media Center will convert it into an all-singing, all-dancing personal video recorder (PVR) that can watch, record and time-slip TV programmes. You can also buy a remote control and receiver to operate it from a distance — ideal if you can connect the computer to a high-definition TV. What’s more, if you have an Xbox 360 games console, it can be used as a Media Center Extender. If you have a home network, this can give access to all your music, video and TV in another room.

**Business class**

Although most computers you’ll find for sale include Vista Home Premium, it’s not uncommon to find notebooks that use Vista Business instead. As the name makes abundantly clear, this version is mainly intended for corporate use, but it also includes a couple of hidden extras that can be useful at home, too.

Windows Shadow Copy sounds bizarre, but it’s a really handy feature that runs in the background, saving each previous version of a file — so if, for example, you accidentally crop somebody’s head out of a photo then save it, Shadow Copy will have kept the original safe for you. The Vista Business backup tool has a clever trick up its sleeve, too: it can create disk image files. With disk imaging programs available for approximately Rs. 2878, this can be a real money saver, as well as a great way to back up all your files.

Another great hidden feature of Vista Business is the Encrypting File System (EFS). This allows you to quickly and easily scramble the contents of a file or folder so that it can’t be read by other users or anyone who might have stolen your computer.

Despite being businesslike, this version still includes the Aero desktop with all its graphical eye-candy. On the other hand, a few features found in Home Premium are missing. You can’t make video DVD discs, for instance, and there is no Windows Media Center. A boxed copy of Vista Business costs around approximately Rs. 8,632.

**Superlative stuff**

Interestingly, Vista Ultimate — the biggest and most complete version of Vista — can be found online for around approximately Rs. 13,667, making it cheaper than the lesser Business version. Ultimate is notable for including just about every feature from all the other versions of Vista, with home entertainment tools such as Media Center and DVD burning and the office tools from Vista Business built-in. This makes it ideal for the indecisive or completists, but does it have any hidden extras all to itself, and are they any good?

The answer is yes and no. Vista Ultimate includes access to a collection of ‘Ultimate Extras’ but so far these have been rather underwhelming: you can download new sounds, video wallpaper, and a poker game for example, but nothing truly groundbreaking.

On the other hand, Vista Ultimate has a hidden trick in the form of Bitlocker. Although Vista Business can use its EFS system to quickly encrypt files and folders, Bitlocker enables Ultimate users to encrypt their entire hard disk should they wish. A USB memory key can be used in place of a password, and the computer will not start Windows without that memory key plugged in.
Supporting role
When referring to prices, we've given the price for a boxed retail copy of Windows Vista. This is because most versions of Vista are available in two types: boxed retail copies and Original Equipment Manufacturer (OEM) copies. When you buy a computer with Windows installed you'll get the OEM version, but if choosing a copy of Vista yourself, either for a new PC or an upgrade, it’s worth knowing the difference.

Retail boxed copies of Vista are designed to be sold to computer owners. They’re more expensive but they include a manual and, more importantly, support. Microsoft includes 90 days of technical support, via phone or email, from the day you activate a retail copy of Vista, so if you hit problems it should be able to help — unless your problem involves connecting to a network, which is an ‘advanced’ support issue and not covered.

OEM copies of Vista are designed for people who make or sell computers. They’re cheaper, but don’t include a manual or any support from Microsoft. Instead, the company that installs the copy of Vista (in most cases the PC manufacturer) pledges to provide support for it themselves. This means that if you bought a computer with Vista you should contact the people you bought your computer from, not Microsoft, for any help. If you buy an OEM version and install it yourself you won’t get any free support from anyone. At just approximately Rs. 5000 for a copy of Home Premium OEM, this may be a sacrifice worth making.

Should you require help from Microsoft, either for an OEM copy or after your 90 days of support are up, it can be purchased for approximately Rs. 3000 per incident. With this in mind, if you think you may need help when installing Vista, it may be worth paying more for a retail boxed copy.

Bits and bytes
Finally, most versions of Vista are available in two further types: 32-bit and 64-bit. These types refer to the way that the computer accesses its memory: older PCs were all 32-bit, but some modern ones can work in 64-bit mode. Generally speaking, it’s still best to install the 32-bit version on home computers, as this is compatible with more peripherals.

The advantage of 64-bit Vista is that it can use more memory: most versions of 32-bit Vista are limited to 4GB of memory, but if you want more, the 64-bit versions can use more than twice as much — if you can afford it.

Whichever version of Vista you choose — unless, of course, you somehow acquire a copy of Vista Starter — you’ll find that it contains useful hidden features that can make your computing life easier. Read on to find out more, and how to get the most from them.
Hidden talents

Windows Vista comes with several gigabytes' worth of hidden applications and utilities lurking beneath its surface. But are any of them worth uncovering? We investigate.

Windows Vista is a large and multi-faceted operating system, and it is virtually unavoidable that some of its key elements will hog the limelight, while others are pushed into the shadows. But just because Microsoft isn’t making a big deal about them, it doesn’t necessarily follow that Vista’s less well-known aspects aren’t worth talking about or bothering to explore.

In fact, as we saw earlier, Vista comes with a huge number of potential gems just waiting to be discovered. These can be roughly divided into two categories — features and functions. It’s a subtle difference, but the former essentially refers to applications, tools and utilities included with Windows, while the latter refers to hidden settings, tweaks and alterations you can apply to your PC to customise or optimise it. We’ll be dealing with the second category later, but before that we’ll put some of Vista’s unsung features under the spotlight, and in the workshops that follow on from this article, demonstrate how to take full advantage of them. So, what are Vista’s hidden features, why are they ‘hidden’, what purpose do they serve and are they any good?

Vista’s multi-tiered strategy

There is no denying Vista is Microsoft’s most complete and feature-packed version of Windows to date. Things have come a long way over the years, but no matter how long you’ve been using Windows — and Vista, in particular — it’s almost certain that there will still be something new to learn.

To some, this is a bonus, with all the hidden extras available only serving to prove that you’re getting your money’s worth when you buy a copy of Windows. On the other hand, Microsoft is often criticised for confusing users by cramming far too much in and for forcing consumers to carry the cost of all the ‘bloatware’ or unnecessary software included in Vista. After all, you’re effectively paying for features that gobble up valuable system resources — features you might not even use.

There’s certainly an argument to be had over whether a one-size-fits-all policy is really the best way to approach something like an operating system. Surely it would be better to create a simple...
system that people can then add (or remove) features to as they see fit? This is something Microsoft has, in fact, gone some way towards addressing with its approach to Vista. Unlike XP and previous Windows releases, Microsoft opted for a multi-tiered strategy for Vista, with several different versions each aimed at a particular user base with specifically tailored features. In this way, a Vista Business user isn’t paying for media features he or she won’t need, for example, while home users won’t find their PCs weighed down by business-related tools and utilities that are completely useless to them.

This time around, Microsoft even produced a fully stripped-down edition of Vista — Windows Vista Home Basic, which comes without many of the big features (such as Media Center and the Aero interface) and fewer hidden ones. See page 14 for a more in-depth comparison of the various versions of Vista.

**Hide and seek**

What’s surprising about some of Vista’s ‘hidden’ features is that they’re hidden at all. Take handwriting and speech recognition, for example. A few years ago, these would have been higher-profile selling points for Vista. Admittedly, the days when controlling a PC by voice or penstroke alone was the Holy Grail of computing have perhaps gone, but that doesn’t make either feature any less useful for those who prefer — or physically require — an alternative to traditional mouse and keyboard input. Indeed, the inclusion of such features within Windows can save you a considerable sum of cash. It’s possible, for example, to buy a standalone speech recognition program from a third-party developer, such as Dragon Naturally Speaking 10. Such a program might have certain advantages — it might contain better tutorials, for example — but is it worth approximately Rs. 10,600, when a perfectly serviceable alternative comes built into your PC?

The same can be said for many of the other tools that appear when you give Vista a shake. Everyone has a hectic schedule nowadays, and thankfully Vista introduces, for the first time, a built-in calendar to ensure you never miss an appointment. Previously, anyone wanting to use their computers to keep an electronic diary or to-do list would have to invest in expensive approximately Rs. 7,200 and up)

Vista includes some great features, but occasionally there are better alternatives available, such as Paint.net.

---

Vista’s hidden flaws

While there’s plenty to like about Vista — the best version of Windows so far — a certain amount of criticism has been levelled against it. Many complaints involve performance issues, while other objections centre on the limited functionality of many of Vista’s built-in features. Thankfully, whether you’re looking for a speed increase or you’d like to fill some of the holes in Vista’s armoury of applications and utilities, there’s a high chance you’ll find a setting you can tweak or a third-party tool you can use instead. We’re not saying Vista’s perfect; there are still a few minor problems here and there, but by following our advice and by using some of the software on our free CD, many of these can be quickly laid to rest.
the creation of a huge number of websites dedicated to various types of news. Whether you’re interested in current affairs, celebrity news or sport, there is a website that can provide you with the latest headlines. However, it’s unlikely that you’ll be interested in just a single topic, and keeping abreast of the latest developments could mean visiting a very large number of sites. This is where RSS feeds come in.

Basically, RSS feeds allow Internet Explorer to automatically download headlines from specific sites and sources, displaying them on one easily accessible page. Rather than having to read through every story to find something you’re interested in, simply browse through the headlines and click one to read the full story.

In our workshop on, we show you how to subscribe to RSS feeds and how to set up your desktop Sidebar so you always have the latest headlines at your fingertips.

Read all about it
Some of Vista’s new features are so small, they can at first seem insignificant, but can in fact have a major impact on your day-to-day computer use. Internet Explorer’s RSS capabilities are a good example. The ever-increasing popularity of the internet has led to the creation of a huge number of websites dedicated to various types of news. Whether you’re interested in current affairs, celebrity news or sport, there is a website that can provide you with the latest headlines. However, it’s unlikely that you’ll be interested in just a single topic, and keeping abreast of the latest developments could mean visiting a very large number of sites. This is where RSS feeds come in.

Basically, RSS feeds allow Internet Explorer to automatically download headlines from specific sites and sources, displaying them on one easily accessible page. Rather than having to read through every story to find something you’re interested in, simply browse through the headlines and click one to read the full story. In our workshop on, we show you how to subscribe to RSS feeds and how to set up your desktop Sidebar so you always have the latest headlines at your fingertips.

Clever little tricks
Some of Vista’s features are hidden because they’re meant to be. Sync Center, for example, is an extremely useful utility, but is only intended to make itself known to those who want to synchronise compatible portable devices — MP3 players, PDAs and mobile phones, for example. Using Sync Center, it’s possible to automatically synchronise data stored on a media device or storage card with your Windows Media Player Library. If you’re working with Vista Ultimate, the tools have even more uses. Synchronisation can be set up between a local and a network folder, so if you regularly work with the same files from several computers, it’s easy to keep all copies in sync so you’re always working with the most recently edited version.

Windows Ultimate Extras
Anyone with Vista Ultimate installed has access to even more tools and utilities, including additional backup facilities, better security and a direct pipeline to further useful features via Windows Ultimate Extras. Downloadable through Windows Update, Ultimate Extras are exclusive features that can be added for free. Extras currently available include Dreamscene, which allows video files to be used as a desktop background; Bitlocker Drive Preparation Tool, which can be used to automate preparing a partition for encryption; and card game Hold ‘Em Poker. Ultimate Extras has been the subject of derision due to the small number of tools released, but this is set to change. One still in the pipeline is Group Shot, a photo-editing tool that can be used to create a perfect photograph by picking the best bits out of a series of shots. There’s currently no release date, but it is certainly one to look out for.
Other Vista features remain somewhat obscure because they take advantage of emerging technology. Sideshow, for example, runs a series of mini-programs that can be used to display different types of information on a separate screen, such as a digital photo frame, remote control handset or secondary display. Such mini-programs could allow you access to your email inbox, a list of RSS feeds you’ve subscribed to, a local weather forecast and more — even when your computer is switched off. It’s a clever little trick, but not one that many hardware manufacturers have taken advantage of — yet.

**Versatile Vista**

The other thing we’ll be doing throughout this Ultimate Guide is discovering hidden features within features you may already be familiar with. Take Windows DVD Maker, which comes with Vista Home Premium and Vista Ultimate. It’s not much of a ‘secret’ in itself — Microsoft is more than happy to sing the praises of Vista’s built-in DVD burning tool. However, what you might not know is that it can be used to create massive MP3 DVDs that can be played on your set-top DVD player or in your car. You can also burn DVDs of recorded TV programmes from within Windows Media Center. These are just a couple of examples of how many of Vista’s tools are more versatile than you might at first think.

A number of other Vista tools sometimes get ignored because they can initially seem like they don’t have a use that’s relevant to home users. Meeting Space would probably fit this category fairly neatly. At first glance, it appears to be (and, indeed, was designed to be) a tool for businesses users. The little utility makes it possible to share what is displayed on your monitor with others on the same network. But, although Meeting Space was no doubt intended for making presentations to large groups of people during business meetings, it can also be put to other uses, including displaying photographs on the screens of more than one computer. By making use of Meeting Space, another computer on the same network, or a notebook connected wirelessly, can be used to display photos while you control the slideshow from another machine. The same program could be used to allow two or more people to research a topic on separate PCs and collaborate on a newsletter, or similar.

**Putting them to use**

Of course, not everyone will make use of all Vista’s features. For example, while it’s fairly easy to pop in a USB memory key to take advantage of the Readyboost performance enhancing feature, only those with special hybrid hard disks in their PCs will be able to make use of Readydrive.

Hardware requirements aside, there are probably dozens of features you may never want or need to use. Whether you ever investigate Vista’s often overlooked built-in games, for instance, is largely a matter of taste. But for all the features you’re likely to ignore, there are dozens more you’ll find useful, and once you find out how handy they are, you’ll wonder how you ever lived without them.

Our aim with this Ultimate Guide is to point you in the direction of these useful features and show you how to get more from your Windows PC. There’s a lot to learn, but the resulting knowledge will vastly improve your computer skills and there’s also a great deal of fun to be had along the way. Read on to venture into uncharted waters and maximise your PC’s potential.
Control Vista with your voice

Did you know you can control Vista with your voice alone? Read on to find out how.

Speech recognition software lets you control your computer by speaking to it. Before Vista came along, you had to install extra software if you wanted to use speech recognition. Now, with a bit of patience, some speakers and a microphone, you can tell your PC what to do without spending extra cash.

We found that speech recognition worked particularly well when dictating letters in Word and Wordpad, but you can also use it to navigate around your computer, send emails and even surf the internet. It does take some patience and is not as quick as using a keyboard and mouse, but it is liberating to be able to control your computer hands-free.

By the time you complete this Workshop, you will have learnt how to set up a microphone, and your computer will be following your spoken commands.

Step 1
A headset with a microphone works particularly well with speech recognition, as it gives you the freedom to move away from your desk and to work hands-free. These start from about approximately Rs. 432 and are available from any good electronics shop. If you have the more expensive sort of headset that works via USB, you can plug it into a free USB port on either the front or back of your PC. Got a non-USB headset? Insert the mic plug into the pink port on the back of your PC (it may have a microphone logo next to it). If you’ve got a standalone microphone, just plug it into the pink mic-in port.

Step 2
When you plug in the mic, a box should appear on screen. If it doesn’t, go to Start > Control Panel > Hardware and Sound > Manage Audio Devices > Recording. Make sure ‘Mic in’ is ticked and then click OK > click OK again. Check that you have switched your microphone on and its volume control is set to a reasonable level. If you are using a headset, make sure it is not on mute. Now you are going to check that your microphone is working properly. Click Start > Control Panel > Ease of Access > then Speech Recognition.

Step 3
In the Speech Recognition Options box, click ‘Start Speech Recognition’. In the next box, select your mic. Click Next and Next again. Say the on-screen instructions and click Next. If Next is greyed out, skip to Step 4. If you do not speak clearly, you will get a message telling you so. If so, click the Back button in the top left of the box. When you see the message, ‘Your microphone is now set up’, click Next. Select ‘Enable document review’ and click Next. Click View Reference Sheet and then ‘Common Speech Recognition Commands’ to see the commands you can use.

If all works well, proceed to step 5.

Step 4
If you could not click Next as mentioned in the previous step, double-check your microphone is switched on, has the volume turned up and is plugged in properly. If every-
thing looks okay, open the Recording tab as described in Step 2, then double-click the microphone icon to open the Properties box. Click the Levels tab. If the button with the speaker icon on it has a red circle with a line through it, this means your settings are on mute. Click the button to take off mute. Also check the position of the Microphone Slider — if it’s too far to the left, then drag and drop it to the right to increase your mic’s volume. Click OK > OK again and start Step 3 again.

**Step 5**
Back in the Speech Recognition Options box, click the ‘Take Speech Tutorial’ box. It is imperative that you do the tutorial before you start to use the speech recognition software. Not only do you learn which commands to use, but while you are doing the training the software is learning how you pronounce words. This means it is more likely to understand you when you begin to use speech recognition. Click or say ‘Next’ and then ‘Next’ again. Follow the on-screen instructions until you have completed the tutorial.

**Step 6**
You can use speech recognition to navigate around your computer, surf the net using Internet Explorer, send emails in Windows Mail, or type documents in Word. If you get stuck, say, ‘What can I say?’ To stop speech recognition say, ‘Stop listening’ and start it up again by saying ‘Start listening’. Speak clearly and slowly. It doesn’t notice coughs, though a giggle makes it ask, ‘What’s that?’ It does not understand you as well as during the tutorial, so it is worth taking the extra training course.

Click Start > Control Panel > Ease of Access > then Speech Recognition. Click the ‘Train your computer to better understand you’ link, press Next and follow the steps.
many people find typing to be a slow, frustrating process. However, if you have a tablet PC or a graphics tablet with a stylus, there is another means of inputting available to you. You might not know it, but Windows Vista supports handwriting recognition. Handwriting recognition is not a new technology, but it has come a long way in recent times. Although handwriting recognition is particularly useful for tablet PC users (which come with touch-sensitive screens), the simple and cheap addition of a graphics tablet to any computer — be it a laptop or desktop machine — can provide the same feature without the need for a special display.

**Step 1**

If you are using a tablet PC, or have installed a graphics tablet, the Tablet PC input panel should be displayed automatically. If this is not the case, click Start, type tablet and click the Tablet PC Input Panel link in the results that are displayed. The first thing to do is choose how the panel should be displayed. Click the Tools menu and choose between floating anywhere on-screen, or docked at the top or bottom of the screen. When writing in the panel, clicking the Insert button adds the writing that has been converted into text into the current document or text field. By default it appears on the right of the screen, but this can be changed by clicking Tools > Option and choosing the Left option if desired.
Step 2
When the input panel is closed, it will shrink down to a small tab at the side of the screen. Choose which side by moving to the Opening tab and making a selection from the list of options. To help improve the on-screen legibility, and the accuracy of text conversion, reduce the width of the ink that is displayed. Move to the Writing Pad and Character Pad tabs in turn and use the dropdown menu to select a new width. In the case of the Writing Pad, use the slider at the bottom of the dialogue box to indicate how little space should remain in the input panel before additional lines are displayed.

Step 3
Vista’s handwriting recognition performs well from the offset, but there will be occasions when text is not successfully converted. If this is the case, click the offending word on the input panel and edit the word on an individual basis. Click any letter that has not been recognised and try rewriting it. Any extra letters or punctuation that have crept in can be removed by clicking the small arrow button beneath a character and selecting the Delete option. If characters are missing from the middle of a word, click the black arrow button beneath the letter after the position it should appear in and select ‘Insert Space to the Left’. The buttons to the right of the input panel can be used to add and delete spaces as required.

Step 4
Handwriting-to-text conversion is generally successful, and most errors can be fixed easily. However, it is possible to increase the accuracy of text conversion by training the software to recognise your particular style of writing. In the input panel, click the Tools menu and select ‘Personalize Handwriting Recognition’. If you have been experiencing problems with the recognition of particular words, select ‘Target specific recognition errors’. Work through the two wizards, providing samples of handwriting for troublesome words and characters. Completing these steps should improve the accuracy and eliminate some of the more common mistakes.

Step 5
For greater accuracy, you can train Vista’s handwriting recognition component to recognise your style of writing. Click Tools, followed by Personalise Handwriting Recognition, then click ‘Teach the recognizer your handwriting style’. Start by selecting the Sentences option and copy each of the passages of text that are displayed using your normal handwriting. If you make any mistakes while writing, use the second button at the bottom of the dialogue box to rub out individual words. Use the third button to wipe the slate clean and start typing a sentence from scratch. There are a number of screens to work through, but by clicking the ‘Save for later’ button you can return to the session later.

Step 6
The stylus provided with your tablet PC or graphics tablet can also be used to navigate Windows. Just use it as you would a mouse cursor. There is another way to make use of the stylus in the form of flicks — movements made with the stylus that can be used as shortcuts to common actions. To configure this option, open the Pen And Input Device Control Panel and move to the Flicks tab. Select ‘Navigational clicks and editing flicks’ before clicking the Customize button. Use the dropdown menus to select which action should be performed when the stylus is moved in a particular direction using the Add option to assign a ‘flick’ to a custom key combination.
Making the most of Windows Calendar

Share your calendar with friends, keep track of dates and appointments, and much more

For a long time, anyone who wanted to use their computer to manage their diary had to turn to dedicated third-party tools such as Microsoft Office Outlook, since pre-Vista Windows lacked even the most basic calendar function. Now, however, all versions of Vista come with Windows Calendar.

Using Windows Calendar’s advanced features, it is possible to create multiple calendars so personal and business appointments can be kept separate. Calendars can even be created in groups as required, shared with others via email, or published to a web server.

There is also the option of subscribing to calendars that have been created by others — either shared calendars belonging to friends and family, or lists of sporting fixtures and other event schedules. Here we explore Windows Calendar’s advanced features.

Step 1
By default, Windows Calendar creates a single calendar that has the same name as your user account. Additional calendars can be created as required, making it easy to keep track of dates and appointments without cluttering a single calendar. Click the File menu and select New Calendar before entering a name and pressing Enter. There is no limit to the number of calendars that can be created, but when several exist, they can become difficult to manage. To simplify things, calendars can be organised into groups. Click the File menu and select New Group. Groups and calendars can also be created by right-clicking within the Calendars pane and selecting the relevant option. You can organise them by dragging and dropping calendars into any group that has been created.

Step 2
Windows Calendar allows for the creation of both appointments and tasks. Appointments can be regarded as traditional diary entries for events that take place on a particular day, at a specific time. Tasks are more long-term events and projects that may have a more open-ended start and finish date. Create a new task by either clicking the New Task button at the top of the screen, or by right-clicking in the Task pane and selecting New Task before entering details to the right. Use the Calendar menu to select which calendar the task should be added to, and set the priority, along with start and send dates. Once a task has been accomplished, tick the Completed box in the right-hand pane or the box next to an item in the Task pane.

Step 3
Appointments can be created in a similar way. Either click the New Appointment toolbar button or right-click within the calendar pane and select New Appointment. After filling in the event details in the right-hand panel, either choose between assigning a particular time to the appointment or setting it up as an all-day event. Appointments that occur on a regular basis can be configured by making a selection from the Recurrence menu, along with choosing when a reminder should be displayed. To invite other people to an appointment, click the Attendees button, select the contact to invite, or create new ones, then click OK, followed by Invite. An email will then be sent out to the selected contacts.

Step 4
To send an entire calendar to someone, either click the Share menu and select ‘Send via E-mail’, or right-click the relevant calendar in the Calendars pane and select the option with the same label. Enter the email address(es) that the calendar should be sent to, and send out the email. The recipient need sim-
ply open the file and the calendar will be imported into their copy of Windows Calendar. It is also possible to send details of an individual appointment to a contact by right-clicking its entry in the central pane and selecting ‘Send via E-mail’.

**Step 5**
To make it easier to collaborate with others, Windows Calendars can be published online, or to a network location. To publish a calendar on the internet you’ll need Webdav, so check with your ISP for information about this. Calendars can also be published to network locations, such as the Public folder on a computer, which can be accessed by others on the network. From the Share menu, select Publish, then use the Browse button to navigate to a suitable network folder. Indicate whether any changes should be published automatically, then use the tick boxes to select what should be published. Click Publish and the option to send an email to others with a link to the calendar will be provided.

**Step 6**
Windows Calendar can be used to subscribe to online calendars that have been created by others. Click the Subscribe toolbar button or click the Share menu, followed by Subscribe. If you know the address of an online calendar, enter it into the box and click Next. Alternatively, browse through a selection of online calendars by clicking the ‘Windows Calendar website’ link. At the bottom of the page are links to sites such as iCalShare and CalendarData.com, where a huge number of calendars can be found. Look through the various categories and locate a calendar you are interested in. Click the link to subscribe, then click Next in Windows Calendar. Choose how often the calendar should be updated, then click Finish.
Back up important files and folders

Tucked away within Vista is a built-in backup utility. Here’s how to take advantage of it.

Personal files are often the most valuable items stored on the hard disk and are hard to replace in case they are corrupted. It is highly recommended to backup your data.

Vista Home Premium includes everything needed to get started. Anyone who is working with a copy of Windows Vista Ultimate has access to an additional backup tool in the form of Complete PC Backup. Rather than just backing up personal files and folders, this tool makes it possible to back up the entire contents of your hard drive, including the programs that are installed and any settings that have been put in place.

Whichever version of Vista you have, it is worth familiarising yourself with its backup utility as it provides a handy means of safeguarding data.

**Step 1**

Launch the backup tool by going to **Start > All Programs > Accessories > System Tools > Backup Status and Configuration**. Ensure you are in the backup section of the program by clicking the Back Up Files link on the left of the screen. In the case of Vista Home Premium, Back Up Files and Restore Files options will be available, while Vista Ultimate adds Complete PC Backup. Assuming this is the first backup to have been created in this way, Windows should indicate that an ‘automatic backup file is not yet set’. Click the button labelled ‘Set up automatic file backup’ and then click **Continue when the User Account Control dialogue box appears**.
Step 2
Vista will then check to see the types of storage device are available to save the backup to. To save the backup to a local hard drive, USB drive or burn the data on a CD or DVD, select the option labelled ‘On a hard disk, CD or DVD’ and then use the dropdown menu to choose a storage location. Alternatively, select the ‘On a network’ option and then use the Browse button to select a folder on a networked computer, which should be used to store the backup before clicking Next. If you have opted to use a network location, provide the username and password to gain access to the computer.

Step 3
The next step is to indicate the types of file you would like to back up. In the majority of cases, it is advisable to leave all the tick boxes selected so that all files will be included in the backup, thereby eliminating the risk of forgetting to include important files. By holding the mouse over one of the labels to the left, a description of what a particular file category includes will be displayed to the right. Files for all users of the computer will be included in the backup, so there is no need to specify individual options. With file types selected, click the Next button to continue.

Step 4
Vista’s backup tool can be configured to automatically run on a schedule. Just how often a backup needs to be updated depends largely on how the computer is used. If new files are created regularly, or existing files are edited frequently, it is a good idea to ensure that updates are made more often than if the computer is not used very much. From the first dropdown menu, choose between running the backup on a schedule daily, weekly or monthly, then use the second menu to specify a day, or date. From the third menu, select a time to run the backup, then click ‘Save settings and start backup’.

Step 5
Vista will now collect information about the types of files that have been marked for inclusion in the backup and will then begin the backup process. Once this is complete, the Backup Status and Configuration screen will indicate that the Automatic File Backup feature is enabled and that the last backup was successful. This screen can be used at any time to update the backup (by clicking the ‘Back up now’ button, the backup will be kept up to date automatically using the scheduling options that have been configured). Use the ‘Change backup setting’ button to make changes to the types of file that should be included in the backup, where it should be stored, or to edit the schedule.

Step 6
To use a backup that has been created, click the Restore Files button to the left of the screen, then click ‘Restore files’. You can choose between working with the most recently created backup, or an older one, before clicking Next and selecting which files and folders to restore. Alternatively, the ‘Advanced restore’ option can be used to restore all the files included in a particular backup or to restore a backup created on a different computer. All that remains is to indicate the location to which files should be restored — this can be the original location, or a different folder. Click the ‘Start restore’ button to extract files from the backup.
Protect kids with parental controls

Find out how you can take control of how and when your children use the PC.

Having broadband at home is great for children; they can use it to do homework, play games and chat online with friends. But it's natural for parents to want to monitor their children's online activities, which is where Windows Vista's parental controls features come in handy.

Built into the User Account aspect of Microsoft's new operating system, the parental controls allow you to tailor and track each user's computer and internet usage. You will need to create a user account for each person who accesses the PC, and they will need to use their personal login details whenever they use it. With this system set up, it's possible to set Vista's controls to specify what each user can and can't do.

Just follow the steps below to create user accounts and set up parental controls.

**Step 1**
The default account that comes with your Vista PC is an administrator account. The first step is to change the name of this account and the picture to personalise it. Left-click on the Start button (the Windows logo icon on the bottom-left of the desktop) and select Control Panel from the Start menu (third up on the right column). Under 'User Accounts and Family Safety', click on the Add or Remove User Accounts option at the top-right of the window. The User Account Control warning will appear, so click Continue. Click on 'Change the account name' and enter a new name in the window that appears. You can include a space in the name if you wish. This does not change the name of the folder in which the files are kept.

**Step 2**
Once you are finished, click on 'Manage Accounts' in the Address bar to return to the Accounts Window. Click on the 'Create a new account' link underneath the list of accounts. Give the account a name (usually the name of the person for whom the account is intended) and select the kind of account you want them to have. In our example, the new account is for a child, so it should be left as a Standard User. Click on the Create Account button to finish the wizard and return to the Manage Accounts window. Now you can create a password for this account.

**Step 3**
Creating a password is important for protecting your data. To make it difficult for unauthorised users to guess your passwords, you should use non-alphabetical characters, as well as regular letters and numbers. You can use spaces as well as upper and lower case, and should avoid using a single word as a password. If you want to use words, it is good practice to run several together. For example, 'safe password' is safer than just 'password' and '$e@fpassw0rd' is even better. It is also a good idea to create a hint to help jog the memory. Be careful that the hint is not too obvious, as anyone using the computer will be able to read it.

**Step 4**
Now you can apply parental controls to the accounts that need them. Click on Start and select Control Panel. Make sure you are logged in under your Administrator account. Click on 'Set up parental controls' in the User Accounts and Family Safety section. Click Continue when Windows asks for your permission. A list of users will be displayed. Click on a user and put a check next to 'On, enforce current settings' to turn on parental controls. It is also a good idea to turn...
on Activity Reporting so you know what that user is doing with the computer. Click next to the ‘On, collect information about computer usage’ option.

Step 5
The options below the Parental Controls and Activity Reporting section allow you to apply more specific controls. Click on the Windows Vista Web Filter to control what the user is allowed to do on the internet. Set the first option to Block some websites or content. If you want to choose which websites to block, check the option labelled ‘Only allow websites that are on the allow list’. In this case, you will have to click on the option labelled ‘Edit the Allow and block list’. On this page, add websites you want blocked or allowed. Click OK when finished. Next choose a restriction level, select the option ‘Block file downloads’ and click OK to save the options.

Step 6
To set when the user can log onto the PC, click the Time limits option. A window will appear with a grid showing times during a week-long period. White squares show the time when the user is allowed to log on and blue squares show when they are not. Click on a square to change its colour, or drag the mouse over several to change many at once. If users try to log on during prohibited times, the PC will ask for an administrator to enter their password. If they use the PC up to the deadline, they’ll receive a warning prompting them to save their work; an administrator option allows them to use the PC for longer.
The first obvious thing to say about Windows DVD Maker is that you’ll only find it if your computer is running either Vista Home Premium or Vista Ultimate. The second thing is that in order to burn DVDs, you need to have a DVD writer of some kind installed on your PC. Compare DVD Maker to many of the dedicated third-party disc-burning applications and it can look simplistic. In fact, this useful utility is more powerful than you might assume. Here, we’ll demonstrate how to use some of DVD Maker’s advanced features and how to troubleshoot the burning process should things not go to plan.

Tip 1
Creating a DVD in Windows DVD Maker can be done in several ways. If you have already been using Windows Movie Maker to edit a home video, you can simply click the ‘Publish Movie’ link on the Movie Maker toolbar and select the DVD option before clicking Next, then OK in the window that appears. Doing this will save your Movie Maker project and launch DVD Maker. Alternatively, if you’re not using Windows Movie Maker and you just want to burn some video files to a disc, simply go to Start > All Programs and select Windows DVD Maker from the list. If it’s your first time using DVD Maker you’ll see a splash screen with some information about the program. Put a tick in the ‘Don’t show this page again’ box to get straight to DVD Maker next time you launch it.
Tip 2
Windows DVD Maker can also create backup data discs. Insert a blank DVD into your drive and an Autoplay window will appear. To perform a backup of files and folders, click on ‘Burn files to disc using Windows’. A dialogue box will open asking you to input a disc title. Type in a name, then click on the down-arrow next to ‘Show formatting options’. There are two types of data disc that can be created. Choose Live File System and you’ll be able to use the DVD like any other kind of data drive, adding and erasing files. DVDs created in this way are not 100 per cent compatible with other operating systems, however. If you want to make sure your disc will be readable in most computers with a DVD drive, choose the second option — Mastered — which still allows you to drag and drop files and folders, but all the files you want to include must be written to the disc at the same time — you can’t add or delete later.

Tip 3
Many set-top DVD players and some car stereos can play MP3 and/or WMA music files and it’s possible to use Windows’ DVD burning capabilities to create a disc of tunes - around 1,000 on a 4.7GB blank DVD. To burn part of your PC’s digital music library to disc, insert a blank DVD and, when the Autoplay window appears, select the ‘Burn a DVD data disc using Windows Media Player’ option. Media Player will launch and you’ll notice an icon for your blank DVD in the right-hand pane. Below this is the Burn List. Drag and drop music there from your main library window. When you’re done, click Start Burn at the bottom of the Burn List.

Tip 4
You can also burn DVDs through Windows Media Center (only available in Vista Home Premium and Ultimate). With Media Center open and a blank DVD in your drive, navigate the vertical menu until you reach the Tasks option, then go right once to select ‘Burn CD/DVD’. Media Center can create three types of DVD: data, video or photo slideshow. To burn a TV show to disc select ‘Video DVD’, click Next, enter a disc title and click Next again. On the following screen, put a check next to ‘Recorded TV’ and click Next. Now select the programme(s) you want by ticking the box to the bottom-right of each thumbnail. Click Next, then Burn DVD.

Tip 5
There are several different types of blank DVD — including DVD-R, DVD-RW, DVD+R, DVD+RW and DVD-Ram — and not all burners or set-top players are compatible. Check the loading tray or instruction booklet of your burner and DVD player to try and establish which types of disc can be used. The logos for compatible formats should be clearly shown. The most widely accepted disc format is write-once DVD-R. If in doubt, try burning to this first. If you’re having problems with a format you’re certain is compatible, you can also try using discs from a different manufacturer, as this can make a surprising difference.

Tip 6
Changing some of DVD Maker’s settings may also help to solve burning and playback issues. In the main DVD Maker window, click the Options link, bottom-right. There are three main things to look at. First, under ‘DVD aspect ratio’ there are two options. If your movies are looking stretched or squashed when you play them back you may need to switch to either 4:3 (for standard TVs) or 16:9 (for widescreen TVs). Under Video format, you should also make sure that the Pal option is selected. If you’re having issues with the burning process itself, it may be worth lowering the speed with which files are being written to the disc. Click the dropdown menu next to DVD burner speed and select ‘Slow’. Click OK to continue.
Get up-to-date news from Internet Explorer

Use your web browser to keep up to date with news and blog posts automatically.

There are many websites whose content changes on a very frequent basis. Sites that are related to the news, blogs and a range of other types of sites that provide up-to-the-minute updates fall into this category. Although it is possible to manually visit one site after another to read the latest news and posts, this can be time-consuming. RSS feeds can be used to alert you to the fact that a particular site has been updated. Only the headline and the introduction to the article are displayed so it is easy to determine which you are interested in, wasting less time browsing through content you are not going to read. Vista’s Internet Explorer 7 supports RSS feeds and handles them in a very similar way to bookmarked sites. Here’s how to subscribe to RSS feeds as well as how to put your feeds to good use.

Step 1
It is easy to tell when a website offers an RSS feed. It is likely that the page itself will advertise the fact somewhere, but when Internet Explorer detects the presence of a feed, the RSS button in the toolbar (the one next to the Home Page button) will change from grey to orange. Some websites feature more than one RSS feed and a complete list of what is available can be viewed by clicking the small black arrow to the right of the button. By clicking either the orange RSS button itself or one of the entries that appear in the dropdown menu, it is possible to view more details about the RSS feeds that have been found.

Step 2
Once a feed is selected, its contents will be displayed. Scroll down the page and a series of articles will be listed. The article title, a snippet of text from the main articles and associated images will appear. To read the full article, click its title or the green arrow that appears to the right. The panel to the upper right of the pages allows article summaries to be filtered. Click on a link in the ‘Sort by’ section to group together articles by the date they were published, their author or title. Alternatively, click a link in the ‘Filter by category’ to view only articles that have been posted to a particular category.

Step 3
Rather than manually viewing RSS feeds using the method in the previous step, Internet Explorer makes it possible to subscribe to a feed so articles will be automatically downloaded without the need to visit the website in question. At the top of the page, click the ‘Subscribe to this feed’ link and enter a name. By default, any RSS feed that is subscribed to will be listed in the Feeds sidebar. When working with a large number of feeds, it is a good idea to organise them into categories, and you can do this by clicking the ‘New folder’ button and entering a name. Ensure the right folder is selected on the ‘Create in’ dropdown menu and click Subscribe.

Step 4
To quickly access a feed that has been subscribed to, click the Favorites Center button in the toolbar (the button featuring a yellow star). By clicking the Feeds button at the top of the panel, subscribed feeds will be shown.
To keep the panel visible at all times, click the ‘Pin the Favorites Center’ button in the upper right-hand corner. Clicking a link in the Feeds section will display the latest articles from the associated RSS feed. While hovering the mouse cursor over a link in this section, two arrows will appear to the right of the link — click this to refresh the feed and display the most recent content.

**Step 5**

Internet Explorer will automatically check subscribed RSS feeds for updates on a daily basis. To change the update frequency of feed, click the Tools button in the toolbar and select Internet Options. Move to the Content tab and click the Settings button in the Feeds section at the bottom of the dialogue box. From the drop-down menu, choose how often Internet Explorer should check for updates and click OK followed by OK. Each feed can be updated using different schedules. When viewing a feed, click the ‘View feed properties’ link to the right of the page, select the ‘Use custom schedule’ option and make a new selection.

**Step 6**

Vista’s Sidebar can display RSS feeds, so they are visible without the need to open a browser. Click the Start button and then All Programs, then select Windows Sidebar from the Accessories group. If the RSS Feeds Gadget is not visible, right-click an empty section of the Sidebar and select Add Gadgets before double-clicking Feed Headlines. Right-click the Gadget in the Sidebar and select Options. All the feeds that have been added to Internet Explorer will be shown, but from the first drop-down menu you can opt to display a single feed — extra Feed Headlines gadgets can also be added. Use the second dropdown menu to choose how many headlines should be shown and click OK.
Get mobile with Sync Center

Configure Vista to automatically synchronise your media files and keep them up to date

Portable digital devices, such as media players, mobile phones and PDAs are now more popular than ever and computer users often want to transfer music and video files to and from these devices and their PCs. While many media players are supplied with software which makes it easy to copy files on and off the device, it can be difficult and time-consuming to ensure all of your music has been copied across — particularly if you have more than one portable player at home. By using Vista’s Sync Center, Windows Media Player can automatically synchronise the contents of your media player with the content of the Media Player library. In some versions of Vista, such as Vista Ultimate, the Sync Center can also be used to synchronise files between network locations, but for this workshop we will focus on media synchronisation.

Step 1
The Sync Center can be accessed in a few ways. The first option is to click the Start button and type ‘sync’. After a pause, Sync Center will be listed in the Programs section and can be launch by clicking its shortcut. Alternatively, the tool can be accessed through the Control Panel. Click the Start button and select Control Panel. Then click the Classic View link and double-click the Sync Center icon. To allow for easier access in the future, the shortcut from the Start menu can be dragged and dropped to the desktop or the Quick Launch bar. With Sync Center open, attach the portable device you want to sync, either by plugging the USB cable into your PC or by enabling a wireless connection.
Step 2
In the Tasks pane to the left of the window, click the link ‘Set up new sync partnerships’. A list of compatible devices will be displayed. If the device you want to work with it not listed, quit Sync Center, ensure the device is connected to the computer and relaunch the program. If it still doesn’t appear, check the manufacturer’s website to see whether the device is compatible with Vista and/or Sync Center. If the device is now visible in the Sync Center window, select it by single-clicking it and a button labelled ‘Set up’ will appear at the top of the list. Click this button and Windows Media Player will launch. Depending on the capacity of the device, a message about not meeting the recommended minimum size may be displayed – just click Yes to continue.

Step 3
To allow Windows to remain in control of the synchronisation process, ensure the box labelled ‘Sync this device automatically’ is ticked at the top of the Device Setup dialogue box. Any playlists which have been configured in Windows Media Player will be added to the list of file to synchronise and displayed in the list to the right. If there are any playlists which you would prefer not to synchronise, simply select it from the list and click the Remove button. The order of playlists can be adjusted by making a selection from the list and clicking the up and down arrows next to the Priority label in the lower right-hand corner.

Step 4
Additional playlists for synchronisation can be selected by clicking the ‘Available playlists’ menu and selecting Sync Playlists. Select any playlists and click the Add button.

A random selection of files can be synchronised by ticking the box labelled ‘Shuffle what syncs’. Use the New Auto Playlist button to create new playlist based on your required criteria and add them to the synchronisation list in the same way. Once all of the settings have been configured, click the Finish button. There will be a pause and Media Player will disappear while the initial sync takes place.

Step 5
Launch Windows Media Player manually and the progress of synchronisation will be displayed in the bottom of the screen. Once the process is complete, a message will be displayed to that effect and you will be told that the device can be disconnected. If the device is plugged in whilst Windows Media Player is running in future, synchronisation will automatically take place. It is also possible to manually start synchronisation by clicking the Start Sync button in the lower right-hand corner of the screen. The icon in the upper right of the screen indicates how much storage space is remaining.

Step 6
Whenever the Sync Center is launched, the device that has just been configured can be seen in the ‘View sync partnerships’ section. Synchronisation can also be achieved from here without the need to launch Windows Media Player; click the Sync All button, or select the device from the list and click Sync. Any problems during synchronisation are listed in the ‘View sync conflicts’ section, while clicking the ‘View sync results’ link will display information about the most recent synchronisation. If the partnership between the Sync Center and a particular device is no longer required, right-click the icon representing the device and select Delete.
Discover Windows Sideshow

Step 1
The number of devices that support the Windows Vista Sideshow feature is increasing, but currently Sideshow is mainly found on notebook computers. Sideshow-compatible devices, such as the Asus W5Fe (http://uk.asus.com), look like an ordinary portable PC, complete with keyboard and standard screen. But when the notebook is closed, an additional smaller screen can be found on the lid. This auxiliary display can be powered whether the laptop is switched on, powered down, or in sleep mode. As the contents of the screen can be viewed even when the computer is not switched on, it is possible to keep up to date with important information, without wasting precious battery power. For example, the contents of your email inbox is at your fingertips without needing to boot into Windows.

Step 2
Sideshow is not limited to notebook computers. There are a variety of devices that offer support in one form or another. Devices such as remote controls and digital photo frames, such as the I-mate Momento (www.momentolive.com), can display Sideshow Gadgets, which are essentially mini applications. The number and range of gadgets available means that devices that previously had a single function — such as controlling a television or displaying digital photos — can be extended into much more useful tools. A compatible TV remote can be used to check emails while watching the television, while a digital photo frame can display not only images, but also the weather forecast or instant messaging conversations. With so many Gadgets to choose from, there is virtually no limit to what can be achieved.

Step 3
A piece of beta software from Microsoft can also be used to bring the power of Sideshow wirelessly to Pocket PCs and smartphones running Windows Mobile 5 or 6. To connect a device of this type using Sideshow, your computer must have Bluetooth capability and your mobile device needs to have .NET Compact Framework 2.0 9 (www.tinyurl.com/rmje9) installed. To download the Sideshow for Windows Mobile tool, visit www.tinyurl.com/4t936h and click the Download button. Save the executable file to the desktop and once the download is complete, double-click it to start the installation.

Step 4
The installer will offer to extract the files to a folder of your choice. Once extracted, connect your Windows Mobile device to the computer using a USB cable and select the option to browse the device. If .NET Compact
Framework 2.0 is not installed, copy the file NETCFv2.wm.armv4i.cab to the My Documents folder, run the file, then restart. Now copy the file WindowsSideShowForWindowsMobile.cab to your mobile device, establish a Bluetooth connection using the instructions provided with your device and then execute the file to install the Sideshow component.

**Step 5**
On the Today, or Home screen of the Windows Mobile device, scroll to the newly added line that reads ‘Not connected’ and click it. In Vista, open the Bluetooth Control Panel, select your mobile device and click Properties before moving to the Services tab. Select the Windows Sideshow option, click OK and install the required driver when prompted. Back at the mobile device, select the computer it is connected to and click Finish. Initially, the Windows Sideshow screen that appears on your mobile device will display the message ‘No Gadgets are turned on’. For now, to configure program options, click the Menu button followed by Options. Here you can choose how much space Sideshow should occupy on the home screen and how much storage it should use. Bear in mind, the Sideshow for Windows Mobile software is still in development, so it may not always function exactly as expected.

**Step 6**
Gadgets now need to be chosen for display. In Vista, click the Start button followed by the Control Panel link and then double-click the Windows Sideshow icon. Gadgets available automatically can be displayed by ticking the boxes next to them. Some Gadgets require frequent updating, so click the ‘Set my computer to wake automatically’ link and configure a schedule. To get more Gadgets, click the ‘Get more Gadgets online’ link and browse the gallery. Click the Download button next to those you would like to use and select the option to open the file with Windows’ Sidebar. The Gadget can then be enabled through the Control Panel.
Share your files with Meeting Space

Windows Vista’s Meeting Space feature may appear to be a business-oriented tool, but it can also be put to a variety of other uses. It displays the contents of your desktop, or just an individual program, on the screens of other computers on your home network. This could be used to display holiday photos to a large group of people when there are too many viewers to crowd around a single computer screen. The program can also be used to enable different people to work on the same file. If several people in the house are working on the same project, or researching possible holiday destinations, each of them can work on a different computer and post their findings to a shared file that can be accessed by everybody on the network.

**Step 1**
The first time Meeting Space is launched, a message will appear indicating that there are a number of configuration steps that need to be completed – just click the button labelled ‘Yes, continue setting up Windows Meeting Space’. Click **Continue in the Use Account Control dialogue box** and then enter the name that you would like others to see in the People Near Me dialogue box that appears. To make things easier in future, it is a good idea to leave the box labelled ‘Sign me in automatically when Windows starts’ ticked. It is safe to leave the ‘Allow invitations from’ option set to Anyone because no data will be shared without your permission, but ‘Trusted contacts’ may be selected so that only people in your contact list can get in touch. Click **OK** to continue.
Step 2
When the Meeting Space window appears, click the 'Start a new meeting' button. Enter a name for the meeting and choose a password to help increase security. Click the green arrow button and an empty meeting space will be created. Other users on the same network who have Windows Meeting Space running will see that the meeting has started and can join in by clicking the link in the 'Join a meeting near me' section and then entering the relevant password. If another user does not notice that the meeting has started, anyone who is already taking part in the meeting can click the Invite button and send a message to any other network users who are online and signed into People Near Me; just tick the box next to a contact and click ‘Send invitations’.

Step 3
When creating a meeting, you can keep it private. After entering a name and choosing a password for a new meeting, click the Options button at the bottom of the window. Select the option labelled ‘Do not allow people near me to see this meeting’. Click OK, followed by the green arrow button. You can inform others about the meeting by clicking the Invite button, which will send out invitations to online contacts. You need to tell everyone in the meeting the password required to join – this can be done verbally or via email.

Step 4
A useful feature of Meeting Space is the option to share your desktop with others attending the meeting. Click the Share button in the toolbar and click OK at the dialogue box that appears. If you would like to share a program that is running, select it from the list and click Share, otherwise click ‘Browse for a file to open and share’ and select the document you would like everyone to be able to see and click Open followed by Share. If you would like everyone to be able to see all the activity that takes place on the desktop, select the Desktop option and click Share. Any actions performed with the selected program or on the desktop, will be replicated on the screen of other people attending the meeting.

Step 5
When sharing a single program, other program windows will be automatically blanked out to hide them from other users, but everything will be visible if Desktop has been selected. By default, the user who started the sharing is the one in control and everyone else can only view what is on their screen. To pass control to another user, click the Give Control button at the top of the screen and select a user from the list. The person to whom control has been passed can hand it back to the original sharer by clicking the ‘You are in control’ button and selecting Return, or the sharer can regain control by pressing the [Windows] key and [Esc] simultaneously.

Step 6
Several people can collaborate on a single file using the Handouts feature of Meeting Space. In the main program window, click the green plus (‘+') sign in the Handouts section in the lower right-hand corner. Select a file and other users involved in the meeting will be able to open it. Changes made by any user will be seen by everyone, but the original file will not be changed. Any user is free to add a handout to the meeting, not just the person who started it. To send notes to meeting participants, right-click a name in the list to the upper right of the screen, and select ‘Send a note’. This opens a simple instant messaging-type tool.
Instantly improve your PC’s performance

Vista’s hidden features can boost processing speeds and prolong notebook battery life

Everyone wants maximum performance from their system. Although the price of memory is much lower than in the past, not everyone can afford to add more system RAM, or upgrade other components to benefit from a speed boost. But Vista includes two memory features that can be exploited to improve the performance of your computer. Readyboost makes it easy to get an instant increase in memory simply by plugging in a USB memory key or similar. Windows is able to cache frequently used system files so they can be accessed much more quickly than normal. Readydrive, meanwhile, uses the latest hard disk technology to improve the battery life of your notebook PC and can allow it to use a special hibernation mode for faster startup times. Read on to find out more.

Step 1
To use Readyboost, you’ll need a USB memory key, or a memory card that can be used with a digital camera, such as Compact Flash or an SD card. Your removable media must also meet certain criteria in order to be compatible. It needs to have a capacity of at least 256MB and must operate at a high enough speed. There is often no way to determine the operating speed of such memory, but Windows will perform the necessary checks for you. Insert a suitable memory stick or card into the relevant port, and an Autoplay menu will appear giving you the option to open the drive or to speed up the computer. Click the option labelled ‘Speed up my system’.

Step 2
If the Autoplay menu does not appear automatically, open Computer either from the Desktop or the Start menu. Right-click the icon representing the disk that has been inserted and select Properties before clicking on the Readyboost tab. By this point, Windows will have carried out the test necessary to determine whether the drive operates at the required speeds. Should it be found to be too slow, the contents of the Readyboost tab will display the message ‘This device does not have the required performance characteristics for use in speeding up your system’.

To prevent this test from being performed unnecessarily in the future, ensure that the box labelled ‘Stop testing this drive when I plug it in’ is ticked and click OK. Alternatively, click Test Again, to perform the test once more.

Step 3
Assuming the drive has been found to operate at a fast enough speed, the Readyboost tab will read ‘Speed up your system by utilizing the available space on this device’. Start by selecting the option labelled ‘Use this device’. Windows will recommend how much of the drive’s capacity should be set aside for Readyboost but, generally speaking, the more space made available the better. For maximum performance, it is recommended that you set aside the same amount of space for Readyboost as you have system RAM installed — so if 2GB of RAM is installed, Readyboost should also be allowed to use 2GB or more. Use the slider to reserve more or less space as required and then click OK.

Step 4
The performance boost experienced should make it clear that Readyboost has been successfully activated. However, it is also possible to check by opening the allocated drive.
A file named Readyboost (or Readyboost.sfcache if file extensions are visible) can be seen in the root of the drive. Depending on the percentage of the drive set aside for the Readyboost cache, a certain amount of space will remain. This can be used as normal. The amount of space used by Readyboost can be adjusted by moving the slider in the previous step to the left. To stop using the drive, select the option labelled ‘Do not use this device’.

Step 5
Readydrive is of particular benefit to notebook PC users. New, hybrid hard disks comprise a standard hard disk along with some faster flash memory. Frequently used files can be automatically cached from the hard disk to the flash memory, which can be read by Windows much faster. This can not only help to improve system performance, but can extend battery life. Readydrive requires no configuration and there are no options to set, but the feature will only be available on computers with a compatible hard disk. One such disk is the Seagate Momentus 5400 PSD, which comes in a range of capacities and includes 256MB of flash memory.

Step 6
Readydrive hard disks can also make use of a special sleep mode for Vista. To enable this feature, open the Control Panel and double-click the Power Options icon. From the list of power plans, select the one that should be used and then click the ‘Change plan settings’ link below. Click ‘Change advanced power settings’ and expand the Sleep entry in the list of options. Now expand the ‘Allow hybrid sleep’ entry and make sure that the On option is selected from the dropdown menu. Further down the list, use the ‘Power buttons and lid’ section to indicate whether the computer should sleep automatically when the lid is closed.
Have fun with Vista's built-in games

If you reckon Windows games aren't worth playing, think again. Vista has some corkers.

Windows has always come with a modest selection of built-in games, but these are often overlooked — mainly because, they've all been a bit basic. But if you haven't investigated Vista's complimentary collection of games yet, then you might be in for a pleasant surprise. Classics such as Solitaire and Minesweeper are still present, but they have been treated to 3D makeovers and are joined by some equally addictive additional titles, including Purble Place and Inkball. Vista Home Premium and Ultimate Editions boast nine games in total, including two premium games; Chess and Mahjong Titans. There’s even the option to go online and download further puzzles and games — some for free. Here’s our introduction to the frequently ignored fun side of Vista.

Tip 1
Before you begin playing, you may want to customise your games folder using the Vista’s new Games Explorer window. Click the Start button, then in the right-hand Start Menu pane, click Games. From here, you can organise your settings and games and get useful information. Click on a game, and the Community and Support menu includes access to a player community where you can get advice. There is also a link to the game’s website which can be useful for retrieving any updates issued by the publisher. The Parental Controls let users set up individual accounts to control access, set time limits and block or allow games based on content, title or ratings system. If you want to customise one of Vista’s built-in games, double-click on the icon in the Games Explorer, go to Game menu and select the Option...
timers can also be set, so players can work to beat the clock. but the varying degrees of difficulty within the same game mean children can advance at their own pace. useful hints are given throughout; for example, your goal in purble shop is to match your character to the mystery purble behind the curtain. choose features from the shelves. you are then told how many, but not which feature you have right. click on the big tick to get clues.

**tip 5**
more suitable for older children, the idea with inkball is to use the mouse to draw ink strokes or dots to guide balls into the right holes. once a ball hits a line this disappears so players need to redraw lines continually. the difficulty level can be set in the menu bar at the top of the game screen. a good tip is to draw a number of lines at various angles. since the balls bounce back at the angle they hit a wall, it can also be useful to pause the game to attempt a calculation of a ball’s trajectory. click outside the inkball window to pause. click inside the window to resume.

**tip 6**
should vista’s new amusements reignite a passion for play, you could consider downloading some new games. a link provided in the games explorer bar to microsoft’s games website allows the user to play or buy more games (http://zone.msn.com/en/root/default.htm). you’ll find something here for just about every taste — puzzles, word games, trivia, card games, board games, arcade games and much more. you can play some online free of charge. others are free to download but not all levels can be played or they are time-limited. there are also subscription models but this can be expensive. for example, msn’s gamespring will cost from around rs. 560 per month, although it does give access to all full versions of the games hosted.
Customising Vista

Scratch the surface and you’ll find that it’s easy to personalise your copy of Vista – and give your computer a performance boost in the process. We show you how.

Each fresh Windows Vista installation adheres to the default Microsoft settings and works perfectly well out of the box. But did you know that you can tweak and tailor virtually every aspect of Vista to suit your needs, preferences and personality? By experimenting with some of Vista’s lesser-known settings and options, you can put your own stamp on your computer and, as we’re about to find out, it’s well worth doing so.

Settings for sounds, images, security, performance and much more can all be altered. Best of all, you don’t need to be an expert user to get started — all that’s required is a little bit of insider knowledge. Many options can be customised directly within Vista using standard Microsoft settings, but there are also plenty of third-party applications available that provide access to advanced tweaks and tools.

We’ll take you through a selection of the best Vista customisation tips and tricks. Then it’s on to the Workshops, where you can try them out for yourself.

Quick and simple tweaks

The best way to start customising Vista is to right-click an empty part of the Desktop and select the Personalize option. The window that appears lists seven customisation tools, ranging from the appearance of your Desktop through to audio settings and screensavers.

If you want to make a quick and radical change to Vista’s appearance, the Theme option is definitely worth trying out. A Vista Theme is essentially a collection of settings that are all applied at once — these include the wallpaper, screensaver, sounds and even the style of the mouse cursor.

You can select one of the predefined Windows Themes or opt to browse for one on your hard disk. And you needn’t spend ages creating your own if you don’t want to as there are plenty available online free of charge. A quick internet search for ‘Vista Themes’ will give you a huge number of sites, with [www.guimods.com](http://www.guimods.com) and [www.myvistathemes.com](http://www.myvistathemes.com) being two good examples.

Take a moment to look through the other options in the Personalize window; they’re all self-explanatory, easy to use and simple to change back if you decide you don’t like them.

Bypass your mouse

Although Vista’s point-and-click interface makes it easy to navigate with a mouse, it’s often much quicker to use keyboard shortcuts instead. And should a battery-powered mouse run out of juice, these shortcuts provide you with the power to carry on working without it.

You can control almost every aspect of Vista using keyboard shortcuts. And, once you have mastered them, you’ll find most are both easier and quicker than using your mouse.

Microsoft places great emphasis on Vista’s sparkling interface, but there will be times when it’s far quicker and easier to use something called the Command Prompt. Purely text-driven, the Command Prompt tool can be extremely powerful and easy to use. The no-nonsense Command Prompt tool can be used to carry on working without a mouse.
Enhance Vista’s performance
Regardless of the glitz and glamour of Vista, most users’ top priority is to find out how to boost their PC’s performance, especially if it’s running on a PC that’s a few years old. We will soon take you through the top six ways to give Vista a shot in the arm, including how to calm down the processor-hogging special effects, reduce background activity and employ Readyboost to quickly and cheaply increase the amount of memory available. You’ll also find out how to prevent unwanted applications from hogging system resources using Vista’s built-in Msconfig application.

There are plenty of other ways you can give Vista a performance boost, including making sure your hard disk is healthy and running efficiently. To do this, first click on the Start button, type ‘Disk Cleanup’ and press Enter. Vista will prompt you to select a drive, then it will automatically delete unnecessary files, freeing up space on your hard disk.

Boost mobile performance
If you’re running Vista on a laptop, you’ll want to make sure it’s not draining power unnecessarily when away from the mains.

The Vista Mobility Center helps out here by providing easy access to a variety of customisable power-saving options. Since it’s only pertinent to mobile devices such as laptops, you won’t be able to access this feature on a desktop PC running Vista.

There are three preset power plans to choose from (Balanced, Power Saver and High Performance), but the Mobility Center also lets you tweak the individual settings of each.

You’ll also be able to find out exactly what percentage of your battery’s power remains and roughly how long you have before you’ll need to make a dash for a wall socket.

Power plans can be changed manually, but Vista helps out by detecting when you unplug the mains adapter and will automatically switch to a mobile plan to save power.

Clean Desktop
If your Desktop wallpaper is truly a work of art, there’s little point letting a bunch of ugly icons ruin it. To quickly remove all trace of your Desktop icons, all you need do is right-click the Desktop, click View and, from the resulting list, uncheck the Show Desktop Icons option. All your icons will now disappear, leaving you to admire your wallpaper.

Don’t worry, your icons haven’t been lost forever — simply repeat the same process to make them reappear in exactly the same place.

When you first run Vista, the Sidebar appears by default down one side of the screen. The standard components of the Sidebar, commonly known as Gadgets, include a clock, calendar and RSS feed. However, you can replace these with other Gadgets available at no cost online. You’ll need a broadband internet connection to take full advantage of the Sidebar, but once you’ve got it running the way you want, it’s a great way to stay up to date.

Dual-monitor backgrounds
Adding your own wallpaper is a great way to add a personal touch to Vista. But if you have two monitors, Vista’s Display Properties tool will only let you replicate the image on both screens instead of providing the option of stretching it across the two. The end result is that a beautiful landscape scene, for example, turns into a nasty case of double vision.

Displayfusion is a free application that provides you with a collection of advanced Vista wallpaper options, including the ability to place separate images on each monitor or stretch a single image across both. To try it out, head to www.binaryfortress.com/displayfusion and download the Free edition. A Pro version is also available and offers a few more advanced tools, but most users will be more than happy with the free alternative.

Prompt is a no-nonsense way of finding out useful information, such as your computer’s IP address, as well as running basic or even complex commands.

Dual-monitor backgrounds
Adding your own wallpaper is a great way to add a personal touch to Vista. But if you have two monitors, Vista’s Display Properties tool will only let you replicate the image on both screens instead of providing the option of stretching it across the two. The end result is that a beautiful landscape scene, for example, turns into a nasty case of double vision.

Displayfusion is a free application that provides you with a collection of advanced Vista wallpaper options, including the ability to place separate images on each monitor or stretch a single image across both. To try it out, head to www.binaryfortress.com/displayfusion and download the Free edition. A Pro version is also available and offers a few more advanced tools, but most users will be more than happy with the free alternative.

Clean Desktop
If your Desktop wallpaper is truly a work of art, there’s little point letting a bunch of ugly icons ruin it. To quickly remove all trace of your Desktop icons, all you need do is right-click the Desktop, click View and, from the resulting list, uncheck the Show Desktop Icons option. All your icons will now disappear, leaving you to admire your wallpaper.

Don’t worry, your icons haven’t been lost forever — simply repeat the same process to make them reappear in exactly the same place.

When you first run Vista, the Sidebar appears by default down one side of the screen. The standard components of the Sidebar, commonly known as Gadgets, include a clock, calendar and RSS feed. However, you can replace these with other Gadgets available at no cost online. You’ll need a broadband internet connection to take full advantage of the Sidebar, but once you’ve got it running the way you want, it’s a great way to stay up to date.

Prompt is a no-nonsense way of finding out useful information, such as your computer’s IP address, as well as running basic or even complex commands.

Dual-monitor backgrounds
Adding your own wallpaper is a great way to add a personal touch to Vista. But if you have two monitors, Vista’s Display Properties tool will only let you replicate the image on both screens instead of providing the option of stretching it across the two. The end result is that a beautiful landscape scene, for example, turns into a nasty case of double vision.

Displayfusion is a free application that provides you with a collection of advanced Vista wallpaper options, including the ability to place separate images on each monitor or stretch a single image across both. To try it out, head to www.binaryfortress.com/displayfusion and download the Free edition. A Pro version is also available and offers a few more advanced tools, but most users will be more than happy with the free alternative.

Clean Desktop
If your Desktop wallpaper is truly a work of art, there’s little point letting a bunch of ugly icons ruin it. To quickly remove all trace of your Desktop icons, all you need do is right-click the Desktop, click View and, from the resulting list, uncheck the Show Desktop Icons option. All your icons will now disappear, leaving you to admire your wallpaper.

Don’t worry, your icons haven’t been lost forever — simply repeat the same process to make them reappear in exactly the same place.

When you first run Vista, the Sidebar appears by default down one side of the screen. The standard components of the Sidebar, commonly known as Gadgets, include a clock, calendar and RSS feed. However, you can replace these with other Gadgets available at no cost online. You’ll need a broadband internet connection to take full advantage of the Sidebar, but once you’ve got it running the way you want, it’s a great way to stay up to date.

Prompt is a no-nonsense way of finding out useful information, such as your computer’s IP address, as well as running basic or even complex commands.

Dual-monitor backgrounds
Adding your own wallpaper is a great way to add a personal touch to Vista. But if you have two monitors, Vista’s Display Properties tool will only let you replicate the image on both screens instead of providing the option of stretching it across the two. The end result is that a beautiful landscape scene, for example, turns into a nasty case of double vision.

Displayfusion is a free application that provides you with a collection of advanced Vista wallpaper options, including the ability to place separate images on each monitor or stretch a single image across both. To try it out, head to www.binaryfortress.com/displayfusion and download the Free edition. A Pro version is also available and offers a few more advanced tools, but most users will be more than happy with the free alternative.

Clean Desktop
If your Desktop wallpaper is truly a work of art, there’s little point letting a bunch of ugly icons ruin it. To quickly remove all trace of your Desktop icons, all you need do is right-click the Desktop, click View and, from the resulting list, uncheck the Show Desktop Icons option. All your icons will now disappear, leaving you to admire your wallpaper.

Don’t worry, your icons haven’t been lost forever — simply repeat the same process to make them reappear in exactly the same place.

When you first run Vista, the Sidebar appears by default down one side of the screen. The standard components of the Sidebar, commonly known as Gadgets, include a clock, calendar and RSS feed. However, you can replace these with other Gadgets available at no cost online. You’ll need a broadband internet connection to take full advantage of the Sidebar, but once you’ve got it running the way you want, it’s a great way to stay up to date.
drive to clean up and, once you click OK, it will perform an initial scan on the drive. When this completes, you’ll be shown sections of your hard disk that Vista believes can be deleted to free up space. Clicking on each section provides you with more information on the type of files located within. Simply check those selections you want to delete and click OK.

**Defrag your drive**

Another way to improve performance is to run Disk Defragmenter regularly. To locate the tool, head to the Start menu and type defrag into the search box. The defrag process goes through your hard disk, grouping elements that have become scattered over time. Depending on the size of your hard disk, the defrag process can take a considerable amount of time and is something we’d recommend running at night. A good way to ensure that your hard disk is always running efficiently is to set a regular defrag schedule. To do this, click Modify Schedule and then choose a time and frequency. Alternatively, click Defrag Now to start the process immediately.

**Working with Control Panel**

Whether you’re changing the look of Vista, adding a new user account or altering the power settings, Control Panel is a good place to start since it houses a wide range of tools within a single window. It therefore makes sense to spend some time getting to know how it works and customising it to suit your needs. You’ll also discover how to create shortcuts to the most popular items within it.

One of the most well-received components of Vista is its enhanced search tool. In Windows XP, file searches were painfully slow: the hard disk would whirr away for a good five minutes or even longer before returning often irrelevant results.

In Vista, not only are searches almost instantaneous, but you can also hunt down emails, documents and other files based on their contents. We also explain how to use logical search terms such as AND and NOT, along with how to save your favourite searches for future use.

**Take Vista to task**

By default, Vista’s Taskbar sits along the bottom of your screen. It houses the Start button, quick-launch icons and buttons for running applications, along with notification icons for services such as MSN Messenger and your security software.

To customise how this looks and operates, right-click the Start button and select Properties. You’ll now see a range of options, including tabs for the Taskbar, Start Menu, Notification Area and Toolbars. Click on the Customize button within the Start Menu tab and you’ll find a host of options to play with. You’ll be pleased to hear you can’t damage your PC by changing any of these options, although it’s a good idea to create a System Restore point first or make a note of those options you change.

More options are available under the other three tabs. The Notification Area section allows you to adjust settings, such as specifying which icons should be hidden (either when inactive or all the time), while the Taskbar tab provides access to features including turning off grouping for similar Taskbar buttons and hiding the Taskbar from view when not in use. By unchecking the Lock the Taskbar option, you can change the size of the Taskbar as well as move it to a different position on your screen.
Ultimate extras
Those running the Ultimate version of Vista also have access to a range of free add-on applications. To find out what add-ons are available for download, click on the Start button, type ‘Extras’ and press Enter. You’ll now be directed to the Windows Update site where you’ll be told if there are new Extras available for download. If there are, click on the View Available Extras link to read more about the individual applications and then select those you want to install.

The next steps
As we’ve demonstrated, if you don’t like a certain aspect of Vista there’s a good chance you’ll be able to change it to suit your needs. And with an almost endless range of customisable features available, it’s well worth getting hold of some software to help you tweak your copy of the operating system. You’ll not only add your own personal touch to Vista, but also enhance its performance.

Over the next few pages, we’ll take you through some of the most popular customisation tweaks, so read on to find out how to make your version of Vista truly unique.

Invisible shortcuts
A rather frustrating feature of Vista is that if you create a shortcut icon for an application, that icon is then blighted by an unsightly curved arrow in the bottom-left corner. Although by no means detrimental, it can ruin an attractive-looking Desktop. To remove these arrows from shortcut icons, all you need to do is download a free application called Vista Shortcut Manager from www.frameworkx.com. This simple tool is easy to use and, if you’d rather not remove the arrow completely, has an alternative option to make the arrows less obtrusive.

Tweaking software
If you fancy taking your Vista customisation further, there are plenty of applications to give you a helping hand. One of the most popular is Stardock Tweakvista, which offers the option of one-click enhancements along with more advanced options. Download a free trial version of the software from www.stardock.com.

Tweakvista is just one of many third-party tweaking applications that helps you to customise Windows

Tweakvista provides similar functionality to Tweakvista, but the Basic Edition is free so it’s well worth checking out. There’s plenty for beginners and advanced users, spanning everything from changing the look of Vista to enhancing performance. Download Tweakvki from www.totalidea.com/product.php.

Windowblinds is another well-established application that lets you customise Vista. Using its skinning tools, you can completely change the look of Vista’s interface in one go. Download a free trial version from www.stardock.com.

There are many more Vista customisation applications on the cover CD, as well as a complete guide to using one of them – namely Tuneup Utilities 2007.
Master Vista’s Control Panel

Understanding the Control Panel is the secret to managing Vista. Here are our top tips

The Control Panel is home to many of Windows’ advanced system configuration options such as display, sound and security settings.

It has been with us for many years and hasn’t really changed much in appearance during that time, despite the addition of several functions.

However, in Windows Vista, Microsoft has radically altered the Control Panel’s look and feel, which can create confusion among users, even for those who are more experienced.

In this section, we will give you a guided tour around the new interface, show you some of the most useful new features and help you discover some of the lesser-known but very useful functions within Vista’s Control Panel, such as keyboard shortcuts and Autoplay.

Tip 1
Vista offers several ways to open the Control Panel. The easiest is to double-click the icon in the Welcome Center, which runs when Vista starts up. Another way is to press the Start button and choose Control Panel from the list on the right-hand panel of the Start menu. You’ll also find a link to the Control Panel in the task ribbon of your Computer window (Start > Computer). If you’d like a quick-access icon to the Control Panel on your desktop, simply right-click where it says Control Panel in the Start menu and choose Show on Desktop as shown in the picture (right). Another way of running the Control Panel is to type control panel in the Search box on the Start menu and then hit the Enter key.

Tip 2
Now you’ve opened up the Control Panel, you might not like the way it looks, as in Vista all the tasks are arranged by category. It’s easy to make it look like XP’s version by clicking the Classic View link in the left-hand panel. To return to the Vista-type view, click the Control Panel Home link in the left-hand pane, or just click the Back arrow at the top left of the window next to the address bar. If you miss the old-style menu bar (whether in the Control Panel or any other Explorer window), you can toggle it on and off by pressing the Alt key on your keyboard. From here, you can make the menu bar permanently visible by choosing Tools > Folder Options, then clicking on the View tab as shown in the screenshot (left).

Tip 3
The default Classic View of the Control Panel is useful but still not perfect. You get to see an icon for every applet, but they’re only sorted by name, making it hard to pick out what you need. It’s easy to organise this view, though — just right-click an empty part of the window and select Group By > Category. You’ll still see an icon for every applet, but this time they’re displayed in categories. Another irritation with the regular icon view is that long applet names are only partially displayed (‘Problem Reports and Solutions’ becomes ‘Problem Reports a...’ for instance). Display the applets as tiles (right-click in the window, select View > Tiles) to always see the full name.

Tip 4
If your choice of Control Panel layout doesn’t help you find the function you need then Windows search should be able to help. Click in the search box at the top-right of the window, then type a word or two that relates to the feature you’re looking for: disk,
printer, mouse, whatever it might be, and Windows will display a list of related links. Integrated search is a big step forward, but keep in mind that it only works fully in category view. Type Printer there, for example, and you’ll get links to add or remove printers, share a printer on the network, manage colours, update drivers and more.

Type Printer in Classic View instead and you’ll get a single link to the Printers applet only, not nearly so helpful.

Tip 5
Now you’ve got used to changing the Control Panel’s layout, it’s time to start exploring some of the more advanced ways to use it. Press Start, then immediately type control. Press Enter and the Control Panel will launch. Press Start again, type ncpa.cpl, press Enter and you’ll see the Network Connections window open. You can do the same for many of the items in the Control Panel (the table on the right shows a selection of these shortcuts). This is a great way to launch your most frequently used Control Panel settings without having to move away from the keyboard to pick up your mouse.

Tip 6
To access all the Control Panel functions directly from the Start menu, hover your mouse over the Start button, right-click and select Properties from the menu. You’ll then see a dialogue box with a button labelled ‘Customize...’ at the top right. Click this and scroll down until you see the Control Panel entry, then click the ‘Display as a menu’ button. This will make the Control Panel appear as a fly-out menu on the Start panel rather than opening up in a separate window. You can also do the same for the advanced System Administrative Tools. Just scroll down the Customize list to find the entry, then click the ‘Display on the All Programs and the Start menu’ button.

Tip 7
Windows Vista has the same Display Settings and Network Connections applets as XP, but they’re harder to find. Use System Restore to back up your setting before making any changes to the Registry (type System Restore into the Start menu Search box). Then click Start, type REGEDIT and press Enter on your keyboard to launch the Registry Editor. Now browse to HKEY_LOCAL_MACHINE\SOFTWARE\ Microsoft\Windows\ CurrentVersion\Control Panel\don’t load. Right-click desk.cpl in the right-hand pane and click Delete > Yes to restore Display Settings, and similarly delete ncpa.cpl to restore the Network Connections applet. Reopen the Control Panel and your favourites will have returned.

Tip 8
The Autoplay applet is a welcome addition, delivering a sensible way to decide what your PC should do when you insert an audio CD, DVD or game. Click Control Panel, select Hardware and Sound if you’re using the category view, then click Autoplay to launch it. At its simplest you can use this to set up the media player that will be launched to play a particular file type. So you
can click the DVD movie list, say, and select Play DVD Movie using Windows Media Player. You’ll often have many other actions available, though. Click the Audio CD list, for instance, and you’ll find Windows Vista can be set up to automatically rip music from an audio CD as soon as you insert it.

**Tip 9**

Another Windows Vista change has seen the File Types dialogue box (the place where you’d tell Windows which programs you’d like to use to open a particular file type) relocate from Windows Explorer to the Control Panel. If you want a different application to open when you double-click on MP3 files, for instance, click Programs (or Default Programs) > Associate a file type... to see the new applet. Scroll down the list, clicking on the .mp3 format when you’ve found it, then click Change program and choose your favourite MP3 player. It’s not there? Click Browse and navigate to your chosen program file. Click OK when you’re done, try double-clicking an MP3 file and Windows should now launch the application you’ve just selected.

**Tip 10**

Perhaps the biggest problem with Control Panel is the way all the most useful functionality is spread around several different applets. With just a couple of minutes work you can build your very own custom Control Panel applet that contains only the features you use most often. The tool that will manage all this for you is called the Microsoft Management Console. Click Start, type mmc.exe in the Search box and press [Enter] to launch it, then click File > Add/Remove Snap-in. Browse the contents of the ‘Available snap-ins’ box to discover the functionality that your custom applet will be able to include.

**Tip 11**

Select your favourite applets in the Available snap-ins list, then click Add (click Finish if prompted) to add them to your applet. If you’re not sure what to pick, then we’d opt for Computer Management, Device Manager, Disk Management, Event Viewer, Reliability and Performance Monitor, Services and Windows Firewall. Keep the list as short as possible, though, so it’s easy to find any particular function. Click OK when you’re done. You can then customise the interface if you like, perhaps removing the pointless Actions pane (View > Customize > clear the Action pane box). Click File > Save As to save the applet when you’re done, then launch it from Start > All Programs > Administrative Tools, or create a shortcut.

**Tip 12**

Now let’s have a bit of useful fun using a little-known brand new feature of the Control Panel. We’re going to show you in two steps how to make the standard system clock that appears on the Taskbar show you the time in three different time zones all at once. First, open Control Panel and click on ‘Clock, Language and Region’.

Then click on ‘Add clocks for different time zones’. Your screen should now look like the one in the picture. Click on
the top 'Show this clock' box and choose a time zone from the drop-down list, then give the clock a suitable name. Do the same for Clock two below this, but choose a different zone.

**Tip 13**
Click OK to exit the dialogue box. Now click once on the clock and you should see a picture like the screenshot (right), with three clocks showing the current time in your chosen time zones. If you hover your mouse over the clock for a second or two, you’ll see a mini-version of the clocks pop up. This Workshop has just scratched the surface of what you can do with the Control Panel, so don’t be afraid to explore it as long as you have User Account Control (UAC) enabled. Windows may sometimes warn you if you’re about to make any major changes to your PC. Just click the relevant button to proceed or cancel.

**Tip 14**
If you share your PC with less experienced users then it’s wise to make sure they can’t access these Control Panel features. Give your users their own account (Control Panel > User Accounts > Manage another account > Create an account). Choose the Standard User account and they’ll be unable to do much harm. To complete the job, log in to their account, run REGEDIT as described in Tip 7 and browse to HKEY_CURRENT_USER\Software\Microsoft \Windows\CurrentVersion\Policies\Explorer. Right-click in the right-hand pane, click New DWORD value, and call it NoControlPanel, then double-click this and set its value to 1. Close the Registry Editor and they’ll get a warning message if they try to run Control Panel — your settings are safe.
Tricks for better performance

Vista can be demanding, but a few tweaks will make it run smoothly, even on an ageing PC

Here's the scenario: a PC bought in 2003 is to be upgraded from Windows XP to Vista Home Premium. Before upgrading, we downloaded the Vista Upgrade Advisor from www.tinyurl.com/23dq97, which told us that our PC would be able to run Vista Basic but would not support 'the Windows Aero experience' in Vista Home Premium — meaning we wouldn't get Vista's new Desktop look.

If this sounds familiar, upgrading to a cheap Vista-compatible graphics card may well allow you to run Home Premium with all its graphical flourishes. But, depending on your system's configuration, you may find that using the machine is like wading through treacle. Everything may seem to happen a few seconds too late, or hang for longer than expected. In this Workshop, we'll show you how to perk things up.

**Tip 1**
To reduce the drains that Vista’s visual enhancements impose on slower computers, right-click the Windows Desktop and select Personalize. When the ‘Personalize appearance and sounds’ menu opens, click ‘Window Color and Appearance’, then remove the tick from the Enable Transparency box. This retains most of Aero’s effects but improves its display speed. For an even bigger boost, switch off Aero by clicking the blue link at the bottom of the ‘Window Color and Appearance’ menu. This opens an Appearance Settings dialogue box like the one in Windows XP. Select Windows Vista Basic and click OK. Gain more speed by turning off special effects. To do so, click Start > Control Panel > System and...
Enter. When the System Configuration dialogue box opens, click the Startup tab. This lists background programs that load each time Vista starts. These programs increase the time it takes Vista to load, occupy memory and make small claims on processor time. Untick any you don’t need, which in this example include Acronis, Nero and Quicktime. You may also disable Windows Defender if you have installed third-party internet security software. Click OK, then restart your computer.

Tip 5
When your computer restarts it displays a message detailing the changes you have just made. Click OK to close this and display the System Configuration dialogue box. Click the Services tab to list the background services loaded by Vista. Some of these are rarely needed and can be disabled. For example, untick Tablet PC Input Service if you’re not using a tablet PC, and Terminal Services if you don’t use Remote Desktop. It’s also safe to disable Remote Registry. A Google search for ‘Vista services’ will yield plenty of tips on which of these services can be disabled safely.

Tip 6
To use Vista’s performance-enhancing Readyboost feature you need a Flash memory device, such as a USB memory key, or some other form of memory card and card reader. When you plug in the Flash memory, Vista asks what you want to do with it, and one of the options is ‘Speed up my system’, which you should select. If the device is fast enough to be used for Readyboost, you’ll see a Properties box in which you can configure it. Click ‘Use the device’ and move the slider control to the extreme right to allocate all of it, then click OK. From now on, Vista will use the memory device instead of the hard disk as virtual memory.
Searching and indexing tips

Vista's search tool makes it easier to locate files and programs. Here are some tips

Creating documents is easy. Finding them on your PC a couple of years later, however, is a different matter. Previous versions of Windows had a basic search for locating files and documents, but it was limited. Now Windows Vista has a search facility nearly everywhere you look, and the searches themselves are far more thorough, tracking down programs and emails as well as files, and using tags (keywords) to identify items. Vista also creates something called an index, which monitors the contents of folders to speed up searches.

Here, we'll describe some of the new ways of searching, as well as demonstrate how to customise the Windows index to suit your needs. In addition, we’ll describe techniques for improving your searches to get better results, and explain how to save them for future use.

Tip 1
The most obvious change to searching in Windows Vista is that searches can be made directly from the Start Menu. This becomes useful as more software is installed and the Start Menu becomes more complex. In Windows XP you usually had to navigate through numerous menus. Not so with Windows Vista. Simply click on the Start button and begin typing. For example, type notepad and Vista will display a link for the program Notepad almost instantly. After a slight pause, it will show other documents that include the word 'notepad' in the title or inside the document if it contains text. If the tag ‘notepad’ has been assigned to files (such as digital music or photos), these will appear, too.

Tip 2
Searching via the Start Menu is fine if you have a good idea of what you are looking for, but search results will disappear as soon as a result is clicked. It is possible to do the search again, but this is not ideal if you want to browse the results. With a more experimental search, it is better to use Windows Explorer. To search the contents of your User folder, for example, click on Start and then on Timothy (where ‘Timothy’ is the name of the user who is logged in). In the Explorer window that opens you’ll find a search box in the top-right corner. Click in this box and type what you want to search for.

Tip 3
Both of these methods (Tips 1 and 2) are rather general in their approach; more specific results can be achieved by using the Search tool. Click on Start and then on Search. The Search box is in exactly the same place as in the Windows Explorer window. Type the search term and press Enter. The results can be filtered by clicking on the row of buttons below the search box to show only emails, documents, pictures, music and so on. More information about the files that have been found can be seen by clicking once on the file. A summary of the file is shown at the bottom of the window.

Tip 4
Vista creates an index of files to reduce the time taken by searches. If you have started keeping files in a different folder, include this folder in the indexing process. Go to Start > Control Panel > System and Maintenance > Indexing Options. Click on the Modify button and Continue when the User Account Control (UAC) window appears. Click on ‘Show all locations’, then on Continue in the UAC window. Click on the
small arrow next to Local Disk (C:) to see the folders on the hard disk. Click in the box so a tick appears to add a folder to the indexing process. It may take some time to include the files in the index, as this happens when the computer is idle.

**Tip 5**

Double quotation marks can help to refine a search. For example, “Goodbye Stranger” will only give results containing that exact phrase. You can also use AND and NOT. So, a search for ‘Supertramp AND Logical’ (without quotes) would find files with both terms, and ‘Supertramp NOT Breakfast’ would find all files with Supertramp except those containing Breakfast. You can also search for music files with terms such as ‘artist:Supertramp’ or ‘genre:rock’. Photos can be searched with terms such as ‘datetaken:6/08/2006’. A list of search terms can be found at www.tinyurl.com/22yn7f.

**Tip 6**

One new search feature in Vista is the option to save searches. An example might be searching for all the music by a particular artist, rather than by album or genre. The location of the search is saved too, even though the searches themselves are kept in one place. To save a search, follow Step 3, then click on the Save Search button. Give the search a name and click on Save. To find the saved searches, click on Start, then on your username. In the Explorer window that opens, click on the small arrow to the right of the username in the address bar and then on Searches. A list of all the saved searches appears in the main part of the window. Double-click on the search you require to run it again.
Think about how many times you use your mouse. Opening and closing programs and documents or navigating your way through menus to use commands usually require you to move the mouse pointer and click. This not only takes time, but repeated use of the mouse has also been linked to Repetitive Strain Injury (RSI). Thankfully there is a solution — keyboard shortcuts. Pressing a combination of keys to action commands is not only quicker than using a mouse, it helps alleviate RSI and also has the handy side effect of making you look like a computer expert.

In this Workshop, we’ll show you how to find your way around your computer quickly, teaching you some of the most useful shortcuts that can be used in Vista and a variety of other programs.

**Tip 1**
Finding your way around your PC is easy when you know the right shortcuts. For example, when you next want to get to the Start menu to access a recently opened program or the Control Panel, just press the Windows key (the one with the Windows flag on it between Ctrl and Alt). Want to access something on your Desktop without wasting time minimising open windows? Simply press the Windows key and D. You can also go straight to Windows Explorer by pressing the Windows key and E. Not sure what your PC’s specifications are? Press the Windows key and Pause to go straight to System, which has all the information you need.
Tip 2
Surfing the web with documents and programs open at the same time can result in lots of windows on your screen. Keyboard shortcuts can help you keep them in order. Press Alt and Tab, and hold the Alt key down. Thumbnails of all your open windows will appear in the middle of the screen. With the Alt key held down, press Tab to scroll through the windows. When your required window is selected, release Alt to bring it on screen in its full size. To see the same results in 3D, press the Windows key and Tab, keeping the Windows key held down. Press Tab to scroll, and release the Windows key when the window you want appears.

Tip 3
Some keyboard shortcuts can be used in lots of programs. You can cut a piece of text from, say, a word processing program such as Word, or an email message or web page, and paste it into another document — useful if you want to share something in an email to friends. To do this, first use your mouse to select the text and then press Ctrl and C to copy it. Next, use the keyboard shortcuts in Tip 2 to find the window you want to paste the text into, then use your mouse to select where you want it to go and press Ctrl and V to paste it. You can also cut the text by pressing Ctrl and X, then paste it by pressing Ctrl and V, as before.

Tip 4
Another useful shortcut is Ctrl and Z. This undoes the previous command — handy if you have unwittingly deleted some text. Changed your mind? Press Ctrl and Y to redo the action. Ctrl and N will open a new document in whichever program you are in, saving you the trouble of clicking File and then New. Want to print your work? Press Ctrl and P. If you use the internet regularly, then the F5 key is your friend. This refreshes a web page, which can be useful if you are waiting for, say, the latest football results or want to read someone’s response to your post on a message board.

Tip 5
Some shortcuts are specific to Vista. For instance, when using the Windows Photo Gallery, you can move to the Fix pane by selecting your image, then pressing Ctrl and F. Once there, you can rotate the picture clockwise by pressing Ctrl and . (full stop). To rotate it anti-clockwise, press Ctrl and , (comma). You can zoom in and out of the picture by pressing the + and – keys. The next time you are editing video footage in Windows Movie Maker, save time by pressing I to start a cut and O to end it. To move forward a frame, press L; to move back a frame, J. To rewind footage to the last cut, press Home.

Tip 6
You can create your own keyboard shortcuts. This comes in useful if there’s a program you open regularly, as it will save you navigating your way through the Start menu. Press the Windows key to open the Start menu, then find the program you want to create a shortcut to. Right-click it and select Properties from the menu. In the Properties box that appears, select the Shortcut tab. The panel next to Shortcut Key will say ‘None’. Click in this panel. Next, press the combination of letters you want to be your shortcut — the combination will appear in the Shortcut Key panel. Next, click OK > Continue > Continue again. Press your keyboard shortcut and the program will open.
Learn the secrets of Command Prompt

Hidden beneath Vista’s new interface is a better method of carrying out common tasks

In the early days of personal computers there was no graphical Explorer-type interface, no drag and drop, point and click, or any of the other conveniences we now take for granted. Users instead had to learn cryptic text commands to perform even the simplest of PC tasks. It was all very complicated, which is probably why most people now ignore the last remnant of those days: the Windows Command Prompt.

In fact, the Command Prompt never went away and is still there, even in Windows Vista. Not only that, but Vista’s prompt is actually an efficient way to enter all kinds of useful commands, many of which perform handy PC management tasks that you simply can’t carry out in any other way. It’s also easy to use and, with just a little practice, anyone can start entering commands and make their PC run more smoothly.

Tip 1
It may look old-fashioned, but the Command Prompt has functionality you won’t find elsewhere. Windows Explorer can’t print a list of all the files in a folder, for example, but with the Command Prompt it’s easy. Hold down shift, right-click on a folder and select Open Command Window Here. A command prompt window will appear, with a prompt telling you the current folder (c:\Users\YourName\Desktop\FolderName >, for example). Type DIR | CLIP.EXE and press Enter on your keyboard. The DIR command means ‘list everything in this directory’ (or folder); the | symbol is called a pipe, and sends the listing to another program; and CLIP.EXE places the list in the clipboard. Switch back to your Desktop, launch Notepad (Start > All Programs > Accessories > Notepad) and click Edit > Paste to see your files, then save or print them.

Tip 2
Finding folders can sometimes be tricky, especially when they’re deeply embedded, such as c:\programfiles\appname\data\examples\sample1\look\here. So it’s just as well that the Command Prompt has a solution. Click Start, type cmd.exe in the Search box and press Enter on your keyboard to launch the command prompt. Type SUBST W: "C:\Folder" and press Enter, where W: is replaced by any unused drive letter on your system, and "C:\Folder" is replaced by the path you’d like to access more easily. Now open Explorer and you’ll see a new W: drive. Click that and it will take you directly to C:\Folder (or whichever folder you specified). Browse this or drag and drop files there as you like. When you are done, type SUBST W: /D and press Enter to remove the W: drive, but don’t worry — it is only getting rid of the drive alias; your data remains untouched.

Tip 3
The Command Prompt can help you manage a home network. If you want to turn off your PC but several network users are logged in, then you can send them all a warning with the msg command. Open a Command Prompt. Type something like
Tip 5
Windows Vista uses the Volume Shadow Copy Service to back up your files. It is a useful but by default takes up 15 per cent of your hard disk. To alter this, click Start, type cmd.exe, right-click the link to cmd.exe that appears in the Start Menu and select Run As Administrator. Type VSSADMIN LIST SHADOWSTORAGE to gain security rights and press Enter to see how much disk space is being used. Then enter VSSADMIN RESIZE SHADOWSTORAGE /For=C: /On=C: /Maxsize=10GB to set the maximum available drive space to 10GB, or whatever you would prefer. (If your drive isn’t C, change the letter accordingly.)

Tip 6
Most Command Prompt commands can be tweaked in a number of ways. Type the command’s name followed by /? (as in VSSADMIN /?) to see a list of options. The DIR command is a good example. We have shown how DIR | CLIP.EXE sends a list of the current folder contents to the clipboard, but it can do a lot more. Enter DIR c:\*.PDF /S | CLIP.EXE for instance, and the DIR command will search drive C: for all PDF files, including subfolders, so the clipboard will contain a list of all the PDF files on that drive. Use the /? trick with other commands to find out what they can do, but be careful. Some commands are very powerful, and can overwrite or delete as many files as they find.
Optimise your laptop with Mobility Center

Use this handy hidden Vista feature to tweak the settings of your portable PC

The Mobility Center really is a hidden part of Vista — it is so well concealed that few people even know it is there. What it does is to collect many of the most frequently used settings relating to notebooks, tablet PCs and other portable computers. That largely means power settings, but it also extends to support for plugging in other devices such as a second screen, which is handy if you need to do a presentation (or you just want to watch a film on a bigger screen). You can even make the computer talk to a networked projector, so you don’t have to use too many cables. Remember that the Mobility Options panel will only appear if your computer is running Windows Vista and if it is a notebook PC or similar. Desktop computers, because they rarely operate in different modes, don’t really need the options it contains.

Step 1
The Mobility Center can be found in the Start Menu — the easiest way to launch it is to click Start, type the word mobility, then click on the icon when it appears in the list above. When it loads you will see the main Mobility Center window is split into several sections. From here you can quickly and easily control several aspects of the computer, all of which make it quicker or easier to work or play. Some settings may vary depending on the make and model of your computer, because manufacturers are able to add settings to the panel. However, the main ones we’ll be looking at should always be the same. See step 6 for more information on the panels added by manufacturers.

Step 2
The options at the top-left in our display are for brightness and volume. Not only are these handy for general use, but they also allow you to conserve battery life. Turning the brightness of the screen down a few notches will save valuable power, as will muting the speakers. Muting is also handy if you’re using the computer in the train or on an aeroplane and you don’t want to upset fellow passengers. Another big power drain on the computer’s battery is the wireless network connection. If you’re not going to be using Wifi, turn it off using the relevant panel in the Mobility Center.

Step 3
Battery and power settings are next. The icon will give you a quick overview of how charged the battery is, along with the same information in text form next to it. You can switch between power-saving modes from here as well, allowing you to set one mode for some types of travel and another mode for another method. Pick one from the drop-down list to use it. You can set these modes up using the Power Options control panel (under Control Panel in the Start menu, or click Start and type power, then click the Power Options icon).

Step 4
In the Power Options dialogue box that appears, select the mode you want to change and click ‘Change plan settings’ just beneath it. From here you can select, using the dropdown lists, how long the computer takes to switch off the screen, and so on. Once you’ve made the changes, click ‘Save changes’ to go back to the list of
modes. You can also change more advanced settings (click Change advanced power settings) such as how much of its own power the processor should use in each mode, which will extend the battery life. To create a new mode, in the main Power Options screen click ‘Create a power plan’ on the left and follow the prompts.

Step 5
Mobility Center is also useful if you want to make presentations using your computer. It makes it easy to switch between your normal working mode, in which the screen works as standard, and a presentation mode, in which you might want to attach a second screen or a projector that will be showing the presentation. To use this mode, click Turn On under Presenting in the Mobility Center. You’ll see a new icon, of a projector, appear in the Notification Area. Click this, then select Customize Presentation Settings. In the dialogue box that appears you can set up what happens in presentation mode, including the screensaver, volume and background. By clicking the ‘Connected displays’ button you can also choose the screen on which your presentation will be shown.

Step 6
Notebook manufacturers are able to add settings to the Windows Mobility Center, which appear as separate panels beneath the main one. As you can see from our screenshot, the Samsung notebook we’re using has two extra panels, one of which is used to dim the screen when you’re using only the battery. There’s also a network management panel to set locations in which you use the computer, allowing you to switch between the settings for different networks. On another computer we tested — an HP model — the Mobility Center included a panel for switching hard disk protection on and off, and another for making quick changes to wireless networks.
Getting more from Sidebar Gadgets

There’s more to Vista’s Sidebar than a clock, a photo slideshow and some news headlines.

We wouldn’t claim that the Sidebar is a ‘secret’ feature of Windows Vista — after all it’s usually the first thing that people notice about the new operating system. What’s less well known, however, is that Vista allows you to customise the Sidebar and the Gadgets it contains. Gadgets are mini programs that live in the Sidebar. They can connect to web services to deliver weather information, news updates, traffic maps and slideshows of photo albums. You don’t need to stick to the Gadgets provided in Vista by default, either. With many more Gadgets available free of charge, you can choose from an almost limitless selection of useful tools, such as calculators, games, news, weather, media and communication applications. Follow the tips below to find out how you can put your Sidebar to better use.

**Tip 1**
Windows Sidebar is a pane that runs down one side of the Microsoft Windows Vista Desktop (usually the right-hand side), where you can keep your Gadgets organised and always accessible. If the Sidebar is not displayed, you can open it by going to Start > All programs > Accessories and clicking on the Windows Sidebar option. Depending on how you work, you can choose to keep the Sidebar sitting behind any applications you have open or set it to be visible at all times. To do this, click the Start button then Control Panel. Choose Appearance and Personalisation, and then click Windows Sidebar Properties. Choose the ‘Sidebar is always on top of other windows’ check box and click OK.
**Tip 2**
Windows Vista comes with a basic set of Gadgets that appear by default, to get you started. These include the clock, RSS news feeds and the picture slideshow. You can choose to keep these visible or remove them by hovering your mouse over each icon, which will bring up either one or two buttons in the upper right corner. This includes the close button — depicted by a ('X') — and the options button (shaped like a spanner), which only comes up if the Gadget has settings that can be changed. Clicking on the ('X') will remove the Gadget from the Sidebar. Click on the spanner to personalise the Gadget. For example, clicking on the spanner button for the clock Gadget will let you name it, change its time zone, and set it to show its second hand.

**Tip 3**
You can add more Gadgets to the Sidebar in a variety of ways. You can, for example, add some of the hidden Gadgets installed on your PC. To do this, move your mouse over the Sidebar and click on the big plus ('+') sign in the top right-hand corner. This will bring up a Gadget Gallery that will list a range of mini-apps that can be added. This includes a calendar, a currency converter and a CPU meter reader. Right-click on the Gadget you wish to add to the Sidebar. This will bring up an uninstall option for those featured on the Sidebar and an Add option for any Gadgets that are hidden. Click Add to make the Gadget available in the Sidebar.

**Tip 4**
You are not limited to the pre-installed Gadgets, however, and you’ll find many more online. To search for something, open the Gadget Gallery as described above and then click on the ‘Get More Gadgets Online’ option found at the bottom. Alternatively, right-click in the Sidebar, select Add Gadgets and click on ‘Select more Gadgets online’. This will take you to the Vista Gadget homepage, which lists and rates more than 2,645 Gadgets that can be downloaded for nothing to the Sidebar, including a Google Search tool. To download one, click on the Download tab underneath each icon. This will bring up a warning advising you to be cautious of third-party material.

**Tip 5**
A number of third-party sites offer Gadgets. Gadgets for Vista (www.gadgetsforvista.net), for example, offers MSN music downloads, and a weather gadget from the Met Office (www.metoffice.gov.uk/weather/uk/Gadgets/vista.html) provides detailed weather reports. Alternatively, you could switch to using Yahoo’s equivalent to Vista’s Gadgets. Go to Yahoo Widgets (http://widgets.yahoo.com) and browse through the selection of more than 4,000 Widgets. You’ll also need to download Yahoo’s alternative to the Sidebar. Click the Get Started link on the Widgets home page to find out more.

**Tip 6**
Back in Vista’s Sidebar, you can customise the Sidebar itself. Options range from moving the Gadgets around to changing the opacity of the icons displayed. To do this right-click on the Gadget you wish to edit, then select from the following options; selecting ‘Move’ will let you drag and drop the Gadgets into the order you wish to have them on the Sidebar. Selecting ‘Detach Gadget’ will move it off the Sidebar and onto the Desktop. You can also use the options here to remove a Gadget by selecting the ‘Close Gadget’ option. And, if you don’t want or need the Sidebar or any of its Gadgets, then right-click on the Sidebar itself and select the ‘Close Sidebar’ option to get rid of it.
Tweak Vista with Tuneup Utilities 2007

Revitalise, customise and secure your PC with this one-stop problem-solving toolkit

There are two ways to optimise Windows settings to deliver the best PC performance. You could do everything manually, wading your way through Control Panel applets, browsing the Registry, and tinkering with Windows applications that you never even knew existed. But it’s time-consuming, and there’s always the risk that you’ll change the wrong setting.

It’s much easier to let a third-party ‘tweak’ utility, such as Tuneup Utilities 2007, do the hard work for you. The program provides easy access to all the best interface, Registry, disk and hardware tweaks, and adds tools of its own to clean your Registry, fix hard disk problems, and more. And a 1-Click Maintenance option can find and correct PC problems with a single button press. You’ll find Tuneup Utilities 2007 on our cover CD; read on to find out how to make the best use of it.

**Step 1**

Tuneup Utilities 2007 provides hundreds of ways to optimise your PC and it is hard to know where to begin. But if you click Optimize & Improve > TuneUp System Optimizer > System Advisor, the program will scan your PC, detect obvious problems, and make suggestions on how to fix them. In our case, the System Advisor has pointed out that a particular program on our test PC was consuming lots of memory — we closed it down and noticed an immediate improvement in performance. The Advisor also reminded us that we had left our root C:\ drive shareable across the network. That left us vulnerable to hackers, so we removed that share and our PC became just that little bit safer.

**Step 2**

You’ll probably have your own ideas about the areas of your PC that really need improving, so you can focus on those next. To speed up the Windows interface, for instance, click Customize & Analyze > TuneUp System Control. The Effects, Animation and Menu Appearance tabs offer control over all the fancy Windows Vista animations and special effects, and clicking the Best Performance button will remove them to accelerate your Desktop. Now click Start Menu in the Usage section. Normally menus don’t fly out until your mouse cursor has hovered over them for almost half a second, but why wait? Reduce the delay to 100ms (0.1 seconds) for noticeably faster menu browsing. And if you don’t have a network printer, click Network and clear the ‘Look for printers...’ box to give Explorer a little extra zip.

**Step 3**

Tuneup Utilities 2007 has some useful internet-related tweaks. Click Customize & Analyze > TuneUp System Control > Internet Explorer, for instance, and select the Favourites tab. Here you can hide favourites you don’t want to share with other users of this PC. Click the Performance tab, choose your internet connection speed, and Tuneup Utilities 2007 will optimise Internet Explorer to deliver the best download performance. Click E-Mail and Chat and...
clear the Show Splash Screen option to help Windows Mail load a little faster. Or, if Microsoft Outlook is your email client, click the Outlook tab to access a few interesting settings to play with too.

**Step 4**

Browse through the program and you’ll find Tuneup Utilities 2007 can apply Windows tweaks that you never knew existed. Is your PC set up to display sharp, clear text, for instance? Click Customize & Analyze > TuneUp System Control and choose the Font Smoothing tab. You’ll see three samples of text, each displayed using a different font-smoothing technique. Select the one you like best, and if that’s ClearType then click the ClearType Settings buttons to see more samples using different sub-pixel and contrast options. Select the block of text that looks the clearest and your PC settings will be adjusted accordingly.

**Step 5**

Tuneup Utilities 2007 can also clean up your PC by removing junk. Click Clean up & Repair > TuneUp Disk Cleaner to remove leftover temporary files and other redundant data. Then use the Tune Up Disk Space Explorer to see how your hard disk space is currently being used. Uninstall bulky applications you no longer need and regain all that hard disk space. Tuneup Utilities 2007 can fix the Registry, too. Click Clean up & Repair > TuneUp RegistryCleaner and it will scan your Registry for errors and invalid entries. This only takes a minute or two, and you can fix any problems it discovers with the click of a button.

**Step 6**

If you think life’s too short to spend time tweaking PCs then you could let Tuneup Utilities 2007 handle all the complications for itself. Click Optimize & Improve > TuneUp System Optimizer > 1-Click Maintenance > Start Scan, and the program will clean your Registry and hard drive. Select Settings and you can even schedule the clean-up to run automatically. Some people get nervous about giving any tweaking tool this much control. After all, what if it accidentally deletes an important setting? There’s no need to worry, though. Just launch the Rescue Center and you can undo any change the program has made, so if a problem does occur then you can fix it in seconds.
Preventative medicine

Find out how to limit the need for troubleshooting your computer by looking after it. Here, we suggest some ways to avoid PC problems from the start.

When it comes to computers in general, and Windows in particular, prevention is usually far better than cure. Rather than waiting for something to go wrong and then panicking to find a solution, it is advisable to have a number of safeguards in place to either help avoid problems in the first place, or at least to make it easier to get everything back to normal.

A combination of good practices and preferable computing habits can help to avoid disaster down the line, and Vista includes more features as standard to help avoid problems than any previous version of Windows.

Over the next few pages, we’ll be looking at how many computer crises can be averted altogether with a little know-how.

Avoidance is best

Microsoft understands the old prevention/cure tenet better than most, which is why it has crammed Windows Vista full of new features designed to prevent many problems from ever occurring. One such precautionary element is Vista’s User Account Control (UAC), which is basically a warning message that freezes your screen. In general day-to-day use, it is something you may encounter only rarely. It’s designed to spring into action only when potentially dangerous changes are about to be made to your computer; for example, when certain system settings are accessed.

Usually, User Account Control will not prevent an action from being performed altogether, but you’ll need to click ‘Continue’ to get past it or supply an administrative username and password if you’re logged on with a Standard user account (see below).

While User Account Control can be turned off, it is far from advisable. The very act of disabling the feature can sometimes have detrimental effects in its own right but, more importantly, switching UAC off could potentially leave your system open to abuse from malicious hackers.

Password protected

User accounts are a good way of preventing many kinds of accidental and security-based problems from ever occurring. It is a good idea to assign everybody that uses the computer their own user account and password protect each one. On a basic level, this helps to avoid the potential problem of one user deleting another’s files, and if users are assigned Standard accounts, they can also be prevented from making unwanted changes to system settings. You may even want to consider using a Standard user account yourself for your day-to-day computer use, reserving your Administrator account only for such times when you need to make use of its privileges. With a Standard user account, any action that could change key system settings or works with important system files requires the entry of an Administrator password. As some malware can change settings and files, many threats can be stopped in their tracks by not providing them with Administrator privileges.
Unnatural disaster
Anyone wishing to prevent disaster from happening will naturally be concerned about security issues, and Windows Vista introduces the Security Center as the focal point for this. Security Center ensures there is a firewall in place to protect against the potential threat of malware, as well as ensuring that Automatic Updates are enabled so that Vista always has the latest fixes and patched installed. The Security Center will also warn you if there is no anti-virus software installed (Vista doesn’t feature any built-in antivirus programs, as we’ll see later on), while Windows Defender will help to protect against malware infection, malicious downloads and a variety of other internet-borne threats. Should any of these defence mechanisms be disabled, or if they are not installed, the Security Center will alert you to the fact and suggest steps that should be taken.

The security of Vista’s new web browser — Internet Explorer 7 — also goes a long way to helping protect your computer. It can automatically block access to websites that are known to be malicious (such as phishing sites), and prevent the appearance of pop-up windows, which can often include malicious links.

Another security concern for those with wireless home networks is encryption. Without encryption in place, it could be possible for others to gain access to your internet connection or, worse, your personal files and data.

Online threats
Even with all of these security measures in place, there is still potential for things to take a turn for the worse. To help avoid virus and malware infection, it is important to take care with all online activities. Care should be taken when downloading files from any website, or opening files attached to emails, for example. Do whatever research you can to reassure yourself that the website or email in question is genuine and use a virus scanner on the file before opening or executing it.

One of the most common problems with computers is that over time they slow down to a fraction of their performance speed when they were new. With regular maintenance, however, it is possible to virtually eliminate this slow down. In the Performance section of this Ultimate Guide, we’ll be examining ways in which taking care of your computer and optimising settings will help keep your system running smoothly for as long as possible.

Like any sensitive piece of equipment, it’s important to treat your Vista PC with care in order to prevent it from physically falling into disrepair. For instance, it is possible — although admittedly rare — for power surges to result in too much power being supplied to a system and its components, and this can result in hardware burning out and becoming broken beyond repair. The easiest way to avoid this problem is to invest in a surge protector. These are similar in appear-

Take control of your PC
If other people use your computer, there is always the danger that they will change a system setting or perform a task that has unwanted side-effects. One way to help prevent this from happening is to use Vista’s Parental Controls. This feature has been designed to place restrictions on children using a computer, but it can also be employed to restrict other users. Ensure that there are user accounts set up for everyone who is going to use the computer and that they have Standard rather than Administrator accounts as this will prevent undesired system-wide changes. Now open the Parental Controls Control Panel and work through each user account in turn. It is possible to restrict which programs can be run, block file downloads to help avoid malware infection and also block other websites. Parental Controls also make it possible to place restrictions on when the computer can be accessed and the types of games which can be played.
some earthed metal with your hand and continue doing so while you are working inside your computer.

The inevitable
Unfortunately, no matter how thorough you are with your disaster avoidance strategy, there will still be the occasional, seemingly random, problem that crops up. As such, you need to be not only vigilant and security-conscious in your computer use, but also prepared for the worst.

Hardware failure can all too easily lead to the loss of personal files, so it is extremely important to have a backup strategy in place — and perhaps the best investment any computer owner can make is in a USB hard disk. This could be used to provide extra storage, but it also acts as a relatively cheap and reusable backup medium — more practical and easier to use than recordable CD and DVDs.

Backing up your valuable data, optimising your PC and remaining vigilant when it comes to security — you’ll find that keeping one step ahead of potential pitfalls and preventing problems before they happen are themes that will recur throughout this magazine. But, of course, it’s not always possible to predict what’s going to happen with the intricate and sensitive machine sitting on your desktop. And, with that in mind, you’ll also find that this Ultimate Guide will also arm you with all the knowledge you need to get yourself out of a tight situation and provide you with valuable advice on how to recover should the worst come to the worst.

Verdict
Windows Vista’s web browser, IE7, helps protect your computer against potential threats.

Allow certain pop-ups from particular websites in IE7

A firewall is in place to protect against malware threats
Repairing a corrupt Vista installation

Don’t lose your Vista installation disc – it can come in handy for solving serious problems

A computer is a bit like a house, in that if the foundations are laid badly, or they fall into disrepair, overall stability can suffer. In a computer’s case, the foundations would be the Windows installation. In most instances, if Windows Vista has been installed by your manufacturer, you shouldn’t encounter any problems. But this is not always the case — unseen problems can creep in during the upgrade process or as a result of a later alteration to your setup. In some instances, this can cripple your Windows installation and prevent your PC from starting. In some serious cases, it might be necessary to reinstall Windows from scratch. But before you resort to such measures you can use the tools found on your Vista installation DVD to try repairing your installation yourself. Here are some tips on how to use Vista’s Recovery options.

Tip 1
Conflicts with other software or hardware can cause Windows problems. We’ll be looking at compatibility issues a little later. If you can’t even start your PC to uninstall or disable programs or components, you’ll need to turn to the Windows Recovery Environment (RE) on the Windows Vista DVD. Insert the DVD into the computer and restart it. Press the space bar when the message ‘Press any key to boot from CD or DVD’ appears (if you don’t see this message, you need to change your Bios boot options — press F2 or Del while your PC starts to access the Bios options). The Windows setup software will load. Set ‘Language to install’ to English and ‘Time and currency format’ to English (United Kingdom). This should also change the ‘Keyboard or input method’ to United Kingdom; otherwise, set this as well. Click on Next and then ‘Repair your computer’ to see the different options.

Tip 2
The first trick to try is the Windows Memory Diagnostic Tool. If a computer is behaving erratically with unexplained crashes, the problem could be faulty memory. Windows can cope with many hardware problems, but a faulty memory chip will always cause a crash. Depending on where the problem is on the chip it may not cause problems during installation, only when Windows is used with several applications running at once. In the RE screen, click on the blue Windows Memory Diagnostic Tool text. Select the top option ‘Restart now and check for problems’ and the computer will restart. The memory checking utility will launch automatically and work its way through all of the memory installed on the computer. The computer will restart again when it has finished and Windows will report any problems.

Tip 3
One aspect of Windows that can be fragile is the initial booting process. The file that controls booting can become damaged in a number of different ways. Thankfully, repairing the startup file is very simple. Boot to the Recovery Environment as described in Tip 1, then click on the blue ‘Startup Repair’ text. The
Repair software will look for errors in the boot process and fix them automatically. If the boot problem was caused by installing Windows XP alongside Vista in a dual-boot configuration, the older operating system (OS) will be added to a new boot menu and you will be able to select which OS to start up.

**Tip 4**
If you can’t even boot to Windows to use Vista’s System Restore feature, don’t worry – System Restore is also available as an option from the RE and it’s definitely worth trying if you’re having Windows problems. Click on the blue ‘System Restore’ link and then on Next. A list of all the available System Restore points will be displayed, each with a date and short description. Click on the most recent Restore Point and then on next. Confirm the correct disk to restore, click on Next, then Finish and finally Yes. System Restore will run and then click on the Restart to try Windows again. If this does not solve the problem, try repeating with earlier Restore points.

**Tip 5**
Another feature of the RE is the Command Prompt. This is a window that allows you to enter commands with the keyboard. Boot to the Recovery Environment as described in Tip 1 and click on the blue text ‘Command Prompt’ to open the text window. The new version of the Command Prompt in Vista is much more capable than that found in previous versions of Windows. This is because it can be used to start programs such as anti-spyware or anti-virus software. For example, type ‘notepad’ and press Enter on your keyboard to edit text documents. A list of commands for repairing Windows is at http://blogs.msdn.com/winre.

**Tip 6**
If the repair options outlined aren’t working, use the Command Prompt to rescue your files and save them to a USB memory key. To copy your documents in this way via the Command Prompt, type the following commands, pressing Enter after each:

- `F:` (where F is the drive letter of your USB key)
- `md vistadocuments`
- `cd c:` (where C is the drive letter for your Vista installation)
- `cd\users\[username]\Documents` (where [username] refers to your User Account name)
- `xcopy c:\users\[username]\Documents\*.* f:\vista-documents\*.* /e`

This will copy all of the files in the Documents folder to the external hard disk, the /e includes all subfolders.
Clever ways to cure compatibility ills

Having problems running programs? We offer tips on ironing out compatibility hassles

Vista is one of the most significant upgrades that Microsoft has ever released, and just about every aspect of the operating system has been rewritten to make it better. It does have a down side, though: all these changes mean some old applications won’t install or run properly on your new setup.

If this is the case then your first step should be to look for an update for the program in question. Try checking the author’s support site (there’s often a link on the Help menu), or search for your application at Google to find more advice. The official Windows Vista Application Compatibility Update (http://support.microsoft.com/kb/943302) also improves support for many applications and is worth installing, even if it doesn’t support your program. If that doesn’t work, don’t give up — here are some more tricks you can try.

Tip 1

Locate the shortcut icon for your problem program (either on your desktop or from the Start menu). Right-click on it and select Properties > Compatibility. Put a check next to ‘Run this program in compatibility mode’, choose a version of Windows the program previously worked with and click OK. Now launch the program again. Windows Vista will try to fool it into thinking it’s running under an older version of Windows, hopefully solving the problem. If it doesn’t, return to the Compatibility Mode screen, check all the Settings boxes and try running the program again. If you can’t find an icon for the program, or just need more help getting this to work, click Start > Control Panel > Programs > Use an older program with this version of Windows. This will launch the Program Compatibility Wizard, which will walk you through the configuration process.

Tip 2

The new Windows Vista security schemes will sometimes cause compatibility issues. It’s annoying but fortunately very easy to fix. Just right-click on the icon for your program and select ‘Run as Administrator’. The application will then be able to behave just as it did in the days of XP, and may now run without difficulty. If you find this helps you, right-click on the program’s icon again, select Properties > Compatibility, check the Privilege Level box and click OK. It’ll now run this way all the time, without you having to right-click each time. Running something as an Administrator is a powerful technique, but always remember why: you are, in effect, turning off Windows Vista security for the application. Only do this with programs you completely trust, never something you’ve just found online.

Tip 3

Some applications are nearly Vista compatible, with only a couple of areas causing problems, so a little tweak can make all the difference. If your program is already installed, remove it (Start > Control Panel > Uninstall a Program) and start the setup process again. Choose the Custom installation option, or whatever gives you the most control over the installation settings. Install as few
of the options as possible: the simpler your setup, the less likely you are to have problems. If your software includes a component that runs in the background, you may be asked if you want to run it as a service or an application. Vista and XP treat services differently, so try the ‘application’ option instead.

**Tip 4**
Some programs may not install or run on Vista because there’s a conflict with some other part of your system. Simplify the situation by closing all running applications, including all the non-essential apps with icons in your system tray. You could also try installing a program from Safe Mode (reboot your PC > press F8 > choose Safe Mode from the list). This starts Vista with the minimum of drivers and no startup applications, cutting the chance of conflicts to a minimum. Unfortunately, it also blocks many Windows components, and the installation programs that verify serial codes online won’t work. But if you’re struggling to get a program working, it’s worth a try.

**Tip 5**
Old or buggy device drivers will occasionally prevent programs from running. To check this, run Device Manager (click **Start** > **type devmgmt.msc in the Search box** > **press Enter**) and look for devices marked as faulty with a yellow exclamation mark. Double-click on the problem hardware for help. If all seems well there, you could still try updating other drivers yourself. Video drivers are particularly important. Expand the Display Adapters section of the Device Manager tree, double-click on your graphics card and click Driver to find your current driver version, then click Update Driver to see if Windows can find a later version. This doesn’t always work, so you may have to visit your graphics card manufacturer to see if there’s a later driver available.

**Tip 6**
Some pre-Windows 95 software — particularly games — just won’t run under Vista. The solution is to con the software into thinking it’s running on an ancient PC. Dosbox (www.dosbox.com) is a clever free tool that can emulate Dos (the operating system that came before Windows). You can use it to run old games, such as the original Doom, and it takes care of the video and sound compatibility issues. Freedos (www.freedos.org) is a similar utility with the ability to build bootable Dos CDs (www.fdos.org/bootdisks). If all else fails, you may be able to reboot your system to play a particular game — a minor hassle but better than not being able to run the program at all.
**Solve compatibility woes with Virtual PC**

*If an old program won’t run under Vista, setting up a virtual XP PC is the ultimate solution*

**Step 1**
You can install Microsoft Virtual PC 2007 directly from our cover disc (or you can download it from [www.microsoft.com/windows/products/winfamily/virtualpc](http://www.microsoft.com/windows/products/winfamily/virtualpc)). With no complicated setup options to consider, accept the default settings and it will install in a few moments. Launch Virtual PC and click Settings to configure your first Virtual Machine (VM). This can get complicated, as you’re able to define everything from how the mouse works to the number of hard disks your XP installation will have, but let’s keep things simple. Click File Name and call this VM something like ‘My XP PC’, then select the Memory option and set your VM to use 256MB, or half your PC’s memory — whichever is less. Click OK when you’re done.

**Step 2**
Place your Windows XP disc into your computer’s CD drive, click Start in the Virtual PC console, and a window will show your VM as it boots. Wait 30 seconds — if the Windows XP setup screen still hasn’t appeared then the program probably needs a little help. Click the CD menu and choose ‘Use Physical Drive D:’ (or whatever drive contains your XP disc), then close the VM window and click Start. This time you should see Virtual PC boot from your Windows CD and launch the Setup program. Press Enter on your keyboard to choose the ‘Set up Windows XP now’ option, and work through the installation. This might feel scary, but don’t worry — none of this will affect your Vista installation. Setup is running inside your VM, so your Vista settings will be untouched.

**Step 3**
When Setup has finished, your VM window will contain a complete Windows XP desktop. It will probably be small, but you can resize it in the normal XP way: right-click on an empty part of the desktop, select Properties > Settings and choose a larger resolution. By now you will also have noticed that the VM has ‘captured’ your mouse and keyboard. You’re not able to move the mouse cursor away from its window to launch a Windows Vista program, and pressing the Windows key, or Ctrl
and Alt and Del, only affects your Windows XP installation — not Vista. To switch control back to your Windows Vista system, press ‘Alt Gr’. To return to the VM and Windows XP, just click your mouse somewhere within its window.

**Step 4**
Click Action > Install or Update Virtual Machine Additions in the VM window. Then follow the instructions to complete the setup process. Let the VM reboot when it’s done — you don’t need to reboot your PC.

You now have a Windows XP installation running inside the VM window on your Vista desktop. To install programs there, if your old software is on disc, place it in your optical drive, open the XP version of Explorer, locate the setup file and launch it.

If you have the setup file on your hard disk instead, just drag and drop it onto the XP desktop. After the file has copied there you will be able to double-click on it and install the program as normal.

**Step 5**
Virtual PC can't handle OpenGL, DirectX or any other gaming platforms, so it probably won’t run any of your old games.

Most other software should install without any problems. If you can’t get an old scanner or printer to work with Windows Vista, for instance, then try installing it on a Virtual PC VM instead. If you can’t get a program running under Virtual PC, it might be worth tweaking your VM options. Click Settings and increase the amount of memory available. You may also need to create an extra virtual hard disk, or try turning the VM soundcard off, too.

**Step 6**
You’re now able to run most XP software from within Virtual PC, but how can these applications communicate with the outside world? If your program needs internet access, then click Edit > Settings > Networking and set your network adapter to ‘Shared networking (NAT)’. This tells the VM to act as though it’s in a local network with your Vista installation, so if your host PC is connected to the internet the VM should be, too. If you want to share files created in the VM with your Vista installation, then click Edit > Settings > Shared Folders > Share Folder and specify a Vista folder. Save work there from the VM, and you’ll be able to access it later from Vista.
Fix wireless network connection problems

Resolve Vista network difficulties quickly, whether at home or when using a WiFi hotspot

Wireless networking makes life a lot easier — at least, that’s the theory. But connecting to a wireless network can be troublesome, though the solution is often fairly simple. By following these six steps you will be able to identify and solve the most common problems quickly and easily.

One thing to make sure of before starting is that wireless networking is switched on. On some computers you may need to press a button or flick a switch before the PC can connect — it varies from PC to PC, but look for something marked Wireless, Wifi, 802.11 or with an antenna or radio waves (on Dell computers, hold down Fn and press F2).

If you’re still having connection problems after all your equipment has been checked, then follow our advice to fix the problem.

**Step 1**
The first port of call when checking for wireless network problems is the wireless network icon in the Notification Area, the small collection of icons at the bottom-right of the screen. The icon is a picture of two computer monitors, and if you have a working connection (or if the computer thinks you do) it will be partly covered by a blue-green globe. Hover your mouse over the icon (move the pointer over it but don’t click anything) and a small box will appear showing the strength of the wireless signal and what kind of access is available. If you can’t see the globe, or if you can but there’s still no network connection, the next step is to right-click the icon and select ‘Diagnose and repair’.

**Step 2**
Once you’ve clicked ‘Diagnose and repair’ the computer will go through a process of figuring out what kind of connection you’re trying to make and attempt to reconnect to it. If the problem is temporary, you might find that it fixes itself at this point. Otherwise a window will appear with further options. Depending on the problem, you may be offered the option of trying to connect again or changing the wireless security key (see Step 3). If there’s no response from the network, you could try connecting with a network cable and logging into the router’s control panel to diagnose the fault. To do so, open a web browser and type the router’s address. It will usually be 192.168.0.1 or 192.168.1.1, but details for this and the router’s administrator password will be in its manual.

**Step 3**
Home networks should have some security set up (on the router or access point). A good option is WPA or WPA2 encryption (either or both will appear in the router’s setup page). WEP security is more widely used but is less secure. You will be prompted to enter a ‘key’, which can be any phrase of text. Remember this, as Vista will prompt you to enter it when you want to connect to the network. If you’re using a paid-for public hotspot there may be no security, but you will need to log on to the network. Once connected, open a web browser and you will be directed to a page where you can pay or log in, if you have an account.
Step 4

If you can't find the right name in the list of available wireless networks, it may be that the one to which you're trying to connect has been hidden to prevent unauthorised access. To get to it, select Unnamed Network from the list and click Connect. You will be prompted to type the name of the network — get this from the owner of the network. Windows will then try to connect — if you need a passphrase or security key to access it, you'll be prompted for that. Type it in and click Connect. A common problem here is mistyping of keys — tick the 'Display characters' box to be able to see what you're typing, or copy and paste it from an email or text document.

Step 5

If Windows can't find any networks and your wireless facility is switched on (see introduction), check that the hardware is working. Click Start, then Control Panel, then Network and Sharing Center, then Manage Wireless Connections. Right-click the wireless connection and select Enable. If that doesn't work, click Start and type device, then click Device Manager when it appears above. In Device Manager, double-click Network Adapters to expand it, and look for your wireless network adapter. If it's not there, make sure it's physically connected. Check the fitting; if it's a USB device try it in another port. A yellow exclamation mark in Device Manager means it is not working — try installing the latest drivers from the maker's website. A red X means it has been disabled — right-click it and select Enable.

Step 6

Wireless networks can work over a number of 'channels'. You can set the channel when you set up the network (on your router or wireless access point). If you live in a city with lots of wireless networks around you, choose a channel few others are using to minimise interference. Log in to your router (instructions vary between manufacturers) and choose another channel for the wireless connection (you'll need to reconnect any computers connected to it) and see if performance improves. The placement of the wireless router is also important. If it has 'line of sight' to the computer you'll get a better signal; if not, try to place it so there are fewer obstacles in the way.
Tips and tactics for tighter security

We show you how to improve the safety of your Vista PC with some lesser-known tweaks.

As Windows users, we sometimes get a hard time from users of other operating systems about security. It’s not really fair, especially since Microsoft has made many improvements in this area for Windows Vista. That’s not to say that Vista is perfect — there’s still no built-in anti-virus and one or two other areas need to be tightened up with third-party software but now you get plenty of protection from the moment Vista is installed.

The key to a strong defence is knowing how to get the most from Vista’s built-in tools, and knowing when to start looking farther afield for replacement and/or substitute security utilities from other sources. With that in mind, here are a few cunning ways to ramp up your PC’s protection.

Tip 1
Keeping up to date with the latest security fixes is an essential part of staying safe. Vista includes a tool called Windows Update for this purpose and it should be set to look for updates automatically. It also can check for updates for other Microsoft software. Left-click on the Start button and then on Control Panel. Click on ‘Check for updates’ in the Security section in the left-hand column. While there, click on the ‘Check for updates’ link and follow the instructions to download any available updates. Then click on the Change Settings link and make sure the top option is selected to install updates automatically. Select the bottom option ‘Use Microsoft Update’ to include other Microsoft software when looking for updates. Click on OK. You may need to click on Continue or enter your password for User Account Control (UAC).

Tip 2
Checking for updates to Microsoft software is automatic, but what about software from non-Microsoft sources, such as Nero, Adobe or Roxio? Some applications have built-in update-checking tools but others don’t. There’s a useful utility called Secunia PSI that scans the software installed on the computer and compares it with a list of recent versions. This can be found on our cover disc or downloaded from https://psi.secunia.com. Once installed, this will scan the computer for software that needs updating or is no longer supported. It does not download any updates itself although it does include links to update pages on the internet for some software. It remains in the Notification Area and will periodically display reminders when software needs updating.

Tip 3
Though the Windows Firewall often gets a bad press, there are important things in its favour. First, it is active as soon as Windows starts and it will block all inbound internet communication until Windows Update has done its checks. As many attacks are initiated from these inbound connections it can be a good idea to block them entirely if the network cannot be trusted. To do this, click on the
Start button and then on Control Panel. Click on Security > Windows Firewall > Change settings, then click on Continue when prompted by UAC. Ensure that the Firewall is turned on and select the option ‘Block all incoming connections’. Also, always try to make sure that you are using the computer as an ‘ordinary’ user, i.e. not an Administrator. This helps to stop malware in its tracks and reduces the risk of anyone changing important settings.

**Tip 4**

If you want to limit what a user can do, the guest account is a quick solution. Click on User Accounts and Family Safety in Control Panel, then User Accounts, and finally ‘Manage another account’. Click on Continue when the UAC window appears. Click on the icon for the guest account and then on the ‘Turn On’ button. The Guest account will now appear when people log on. However, the guest account is actually something of a security liability if it is left on, so we recommend disabling it when not in use. Click on the account icon again and select ‘Turn off the guest account’.

**Tip 5**

Your network might be secure, but what about a friend’s Wi-Fi or a public hotspot? When you first connect to a network Vista will ask whether or not the network is public or private. ‘Public’ should be selected if there is any doubt about security. To check or change what a network is set as, go to the Start button and select Control Panel. Click on ‘View network status and tasks’ in the Network and Internet section. A small map of the network is shown. Click on the Customize link underneath the internet icon. Select Public and click on Next. Enter your password, if required, and click Continue in the UAC window. Click on Close.

**Tip 6**

A good way to stop attacks from bad websites is not to allow any contact with them. This can be done with a replacement DNS service such as that provided by ScrubIT (www.scrubit.com). DNS is the way the computer finds a website from the address in the address bar. ScrubIT refuses to pass on the details of sites known to be a problem. Click on ‘View network status and tasks’ in Control Panel and then on ‘Manage network connections’. Right-click on the network connection you are using and select Properties. Double-click on ‘Internet Protocol Version 4 (TCP/IPv4)’. Click on ‘Use the following DNS server addresses’ and enter 67.138.140.100 and 207.225.209.66 then click on OK twice.
Make Vista even better

Windows isn’t perfect and some of its failings are easier to spot than others. We examine Vista’s flaws and how you can get around them with the help of software on our CD.

There’s a lot to like about Windows Vista — good looks, strong security features, improved stability, effective troubleshooting tools and some excellent new applets, to name but a few examples. But let’s be realistic; as with previous versions of Microsoft’s operating system, Vista is not without its faults.

Spend some time with Vista and you’ll begin to spot the hidden flaws, the technical issues that really need to be addressed, and the areas in which the operating system still compares unfavourably with rivals such as Linux or Leopard (Mac OSX). That sounds a little depressing, but it’s only the start. Once you’ve identified the weaknesses in Windows it becomes much easier to patch them up with third-party tools and so deliver a faster, more efficient and productive PC — often for little or no extra cost. In this feature we’ll show you how to compensate for Vista’s shortcomings using free software that you’ll find on our cover CD.

**Poor performance**
The most common complaint about Windows Vista is that it’s a poor performer.

There’s some truth in this, but in part it’s because the operating system is doing more than ever before. It takes lots of memory and system resources to run the stylish Aero interface, for instance, and this may have a noticeable effect on older PCs and notebook PCs.

Still, if your system seems sluggish then you can always turn Aero off. Simply right-click the Desktop, click Personalise > Window Colour and Appearance > Open Classic Appearance Properties... and choose Windows Vista Basic in the Colour Scheme box. There are many other performance-related settings that need to be carefully checked to ensure your system is running at its best.

Replacing Windows’ tools with third-party add-ons can help, too. Some users report that copying files seems slow with Windows Vista, for instance, but we have found Teracopy (www.codesector.com/teracopy.php) can often move data more quickly.

If you find searches in Windows Vista are not as fast as you’d like, try Copernic (www.copernic.com). It locates files in a flash, and uses minimal system resources so won’t interfere with other programs.

The ultimate performance tool is Vlite (www.vlite.net), which builds a custom Windows Vista installation that includes only the components you need. It can deliver great results, but beware — it may also cause problems of its own if you accidentally remove something important. This is one for Windows experts only.
Interface issues
There’s no doubt that Windows Vista looks a lot better than XP. The excellent new wallpaper images, high-resolution icons, transparent windows and clever graphical features all help to create an attractive working environment. And yet Windows Vista is still lagging behind the competition in several important areas.

Take the Desktop, for instance. Linux users can have several virtual desktops, perhaps with a full-screen browser running in one, word processor in another, and smaller applications in a third, then switch between them at a click. Windows Vista users must manage all their applications in a single desktop, which is limiting by comparison. Still, there are utilities that can be of use. Dexpot (www.dexpot.de) and Virtuawin (http://virtuawin.sourceforge.net)

Taming User Account Control
Some people see User Account Control (UAC) as a big Windows Vista flaw. They’re annoyed by all those prompts asking for permission to do just about anything, so they turn it off at the earliest opportunity. But this is a mistake. Not only does UAC help make your PC safer, it’s also the power behind Internet Explorer’s Protected Mode (a handy security bonus in itself) and several other features. Disable UAC and you’ll lose them all. Your system may even develop mysterious new instabilities as a result.

The best solution is to leave UAC turned on. But if you’re tired of the prompts, launch Regedit and go to HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Policies\System. Double-click ConsentPromptBehaviorAdmin in the right-hand pane, set its value to 0 (use 2 later to restore the default setting), and click OK. You won’t see any more alerts, but UAC will continue to run in the background, which means you’ll still benefit from Internet Explorer Protected Mode and its other useful features.

Security matters
Windows Vista’s security has come a long way since Windows XP, but still includes a number of problems that you’ll want to rectify as soon as possible. The new firewall, for instance, is packed with features, yet somehow still makes it difficult to trap outgoing connections. Replace it with the excellent free Comodo firewall (www.personalfirewall.comodo.com).

And while it’s good to see that Windows now includes an anti-spyware tool in Windows Defender, you can’t rely on Windows Defender to protect you from all malware, so get some help from a dedicated anti-virus tool. Thankfully utilities like Avira Antivir are completely free.
really need anti-virus protection too to stay safe online. Avira Antivir (www.free-av.com), Avast antivirus (www.avast.com) or AVG Free (http://free.grisoft.com) will all keep home users safe from a range of malware for no charge at all.

The Windows Vista Recycle Bin sees an impressive new icon, but we’d rather Microsoft had addressed a more significant flaw — namely its inability to securely wipe files. If a Mac user wants to get rid of a confidential file forever then they simply click Secure Empty Trash and it’ll be overwritten in such a way that snoopers with undelete software won’t be able to recover a thing. Windows users must simply choose the Empty Recycle Bin and hope no-one else gets access to their system, and that’s not good enough. Doubtless Microsoft will get around to adding this eventually, but in the meantime you can fix the problem for yourself by installing Eraser (www.heidi.ie).

File encryption is annoyingly reserved for the Windows Vista Business, Enterprise and Ultimate editions. Microsoft apparently believes that home users don’t have any confidential data worth protecting. Still, don’t complain, just download a free copy of Truecrypt (www.truecrypt.org). It can create virtual encrypted drives that will keep all your most private files safe from snoopers.

Backup concerns
Microsoft promised us a shiny new backup tool in Windows Vista, and we got one — but it didn’t entirely live up to expectations. You can ask the utility to back up all the pictures on your drive, for instance, but can’t tell it to pick only the images in a particular folder. That means it’s almost impossible to use the tool for quick, selective backups, and that’s a real disappointment.

Windows Vista also delivered Shadow Copies (automatic backups made at the file level) and Windows Complete PC Backup to make an exact copy of your entire drive. But these were only available if you splashed out on the more expensive editions of Vista. Regular Home Premium users would have to do without.

Fortunately there are several ways around these problems, especially if you apply some lateral thinking. Why not make use of Windows Easy Transfer, for instance? Sure, it’s supposed to be used when you’re moving your settings directly from an old PC to a new one. But so what? The program still effectively lets you save copies of your email, favourites, address book, Windows settings or specific folders to a blank DVD, a USB memory key or a network or external hard disk. And if there’s a disaster you can use these copies to restore everything. Click Start, type Windows Easy Transfer and press Enter on your keyboard to see how this works.

For real control you’ll want to install something more powerful, though, and there are plenty of free tools around. Cobian
Backup (www.educ.umu.se/~cobian/cobianbackup.htm) is a simple yet versatile backup tool, for instance. Driveimage XML (www.runtime.org/driveimage-xml.htm) is a more than adequate replacement for Windows Complete PC Backup that will quickly create a complete image of your drive. And Windows Vista Home Basic or Premium users can gain access to shadow copies by installing Shadow Explorer (www.shadowexplorer.com), although we would recommend trying File Hamster instead (www.mogware.com/FileHamster). This clever program monitors the folders and files you specify, and keeps a copy whenever they are changed or overwritten, so if you lose something important then it’s easy to recover a previous version.

**Bundled applications**

At first glance the bundled Windows Vista applications seem impressive. You can keep track of your schedule with Calendar, run Gadgets on the Sidebar or manage your digital images with Photo Gallery, for instance. And although good old Minesweeper is still there, it’s joined by some graphically gorgeous games that you might actually want to play.

Look a little closer, though, and the news isn’t all good. Built-in apps like Notepad and Paint are still chronically short on features, for example, and the supposedly new Windows Mail is really just Outlook Express with a very thin disguise. The inclusion of Windows Media Centre isn’t all it seems, either — this only comes with the Windows Vista Home Premium or Ultimate editions. Everyone else must rely on Media Player to handle their videos and music.

Overall the built-in applications compare poorly with Linux, which includes powerful tools such as Evolution (email, address book and calendar functionality, the Linux answer to Microsoft Outlook) or Open Office (word processor, spreadsheet, presentation tools), and provides easy access to many more. There’s no need to buy other software, you can be productive with a Linux system from the first time you turn it on.

Still, there’s nothing here that a little judicious downloading can’t solve. Swap Notepad for Editpad Lite (www.editpadpro.com/editpadlite.html) and you’ll get better performance, unlimited undo and redo, and a tabbed interface that allows you to open several files at the same time. Replace Windows Paint with Paint.Net (www.getpaint.net), a feature-packed image editor that’s still easy enough for beginners to use. Windows Mail is not nearly as configurable an email client as Thunderbird (www.mozilla-europe.org/en/products/thunderbird), which can be extended with hundreds of custom add-ons. Mediaportal (www.team-mediaportal.com) is a Media Center-like suite that can play videos, DVDs, music and internet radio. And if you need a professional word processor or spreadsheet then just grab a copy of Open Office (www.openoffice.org) — it’s completely free.

**Easily find updates**

You can get around Windows’ feeble bundled applications by installing replacements, then, but that only highlights another flaw — Windows Vista has almost no software management features.

If a Linux user wants to install or upgrade a program then in many cases they don’t have to waste time searching online, manually downloading files or running installation programs. Instead they just run their package manager, choose the program they want from a menu, then it’s downloaded, installed and later upgraded automatically. There’s no fuss, no hassle or complications, it all just works.

There are no package managers that deliver the same level of functionality for Windows Vista, unfortunately, but we’ve found some tools that can at least make it easier to locate updates for your applications. Install the File Hippo Updatechecker (www.file-hippo.com/updatechecker), for instance, and it’ll scan your PC checking for installed applications, then report back any that have updates available (there’s even a download link). It’s a simple way to find out about the latest versions of your favourite applications and get their new features, bug fixes and speed improvements, without having to keep popping back to their website to check on what’s available.
Updatechecker is incredibly easy to use, but doesn’t recognise that many applications, so it’s a good idea to install at least one more update manager to offer a second opinion. Updatestar (www.updatestar.com) maintains a database of over 80,000 application versions and is probably the best choice, although Sumo (www.kcsoftwares.com/?sumo) is a close second and Secunia PSI (http://psi.secunia.com) is excellent at warning you about security patches that you really should have installed. Try them all, see which one works out best for you.

Fix almost anything
Windows Vista has plenty of flaws, then, but it’s still the best version of Windows yet. And it has one very significant advantage over Linux and Leopard — its large user base. Most people choose to install Windows on their desktops, and so that’s where software developers focus their attention. As a result there are far more services, tools and add-ons available for Windows than any other operating system, more than enough to solve just about any Windows problem.

So if you’re frustrated by some aspect of Vista, the chances are it can be fixed. Tired of Windows’ feeble CD-burning features? Install Burnaware Free (www.burnaware.com/burnaware_free.html). Annoyed you need to access your PC across the internet, but Remote Desktop isn’t included with Windows Vista Home Premium? Use Logmein instead (www.logmein.com). Need a more powerful Media Player that doesn’t use all your system resources? Try VLC (www.videolan.org/vlc). Check out the applications on our cover disc for more ideas, install free tools from software libraries like Snapfiles (www.snapfiles.com) or Freeware Home (http://freeware-home.com) and get Windows working just the way you would like.
Further Vista tips and secrets

More helpful hints, tricks and techniques for getting the most out of Windows Vista

**Tip 1**
Before you make any major changes to the way your PC works, (including any of the Registry tweaks on these pages and elsewhere in the Ultimate Guide), you need to safely back up your Registry.

In Vista, you can back it up by setting a System Restore point. Go to the Start menu, type System Restore and then click on the System Restore icon that appears in the list above. Click Continue if you see a User Account Control (UAC) prompt and, in the next window, click the open System Protection link at the bottom. Now click on Create, give your restore point a recognisable name and click Create again. To revert your Registry back to a previous state, launch System Restore as described above and select 'Choose a different restore point' to find the one you named earlier.

**Tip 2**
Windows Vista automatically reboots your PC after installing a Windows update (if required), which is frustrating if it interrupts something like an overnight download. There are, however, several solutions. Click Control Panel > System and Maintenance > Windows Update > Change Settings and set 'Install new updates'
to a time during the day, when you'll be around to postpone a reboot. Alternatively, just before you go to bed, click Start, type services.msc and press Enter on your keyboard. Double-click the Windows Update service and click Stop > OK. Nothing will be downloaded until you restart again.

**Tip 3**
If you find copying files across your Windows Vista network is slow then there are a couple of obscure tricks to try. First, click Start, type OptionalFeatures.exe and press Enter on your keyboard, clear the box next to Remote Differential Compression and click OK. Reboot, and try copying again. Turn it back on if things are no better. Windows Vista SP1 introduced Registry settings that may help, too. Launch REGEDIT (to do this, type REGEDIT into the Start menu search box) and browse to HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\WindowsNT\CurrentVersion\Multimedia\SystemProfile. Set NetworkThrottlingIndex or SystemResponsiveness to much higher values, perhaps 50 or 60, then reboot to test.

**Tip 4**
Windows Vista launches all kinds of odd components when it boots, whether you need them or not. And some are extremely difficult to track down. Have you heard of the Transient Multi-Monitor Manager (TMM), for instance? It's a tool that helps laptop users configure external monitors. The problem is it launches by default on PCs, even if you have no intention of ever switching monitors. To turn this off click Start, right-click Computer and choose Manage. Navigate to Task Scheduler > Task Scheduler Library > Microsoft > Windows > Mobile PC, right-click TMM in the central pane and choose Disable.

**Tip 5**
The Windows Vista version of Explorer looks very different, but still has some of the same old problems. It often forgets the settings you’ve chosen for individual folders. To start resolving this, go to Start > Computer, press Alt then click Tools > Folder Options > View, and make sure the box to ‘Remember each folder’s view settings’ is checked. If that doesn’t help then your folder settings may be corrupted. Launch REGEDIT, go to HKEY_CURRENT_USER\Software\Classes\LocalSettings\Software\Microsoft\Windows\Shell, right-click Bags in the right-hand pane and delete Edit > Delete > Yes. Repeat the process to erase the BagMRU key, too, then go to HKEY_CURRENT_USER\Software\Microsoft\Windows\Shell, double-click on BagMRU Size, select Decimal and set it to 10000. This should help ensure Explorer remembers your folder settings.

**Tip 6**
Do this to restore the desktop Display Settings option. Launch REGEDIT, browse to HKEY_CLASSES_ROOT\Directory\Background\Shell. Right-click Shell, select New > Key and call it Display Settings. Double-click ‘(Default)’ in the right-hand pane and enter Display Settings in the Value Data box. Right-click Display Settings in the left-hand pane, select New > Key again, and call
this key ‘command’. Double-click this new key’s (Default) value and enter: rundll32 shell32.dll,Control_RunDLL DESK.CPL,@0,3

Click OK, right-click the desktop to bring the option back.

Tip 7
No matter how busy you are working on one PC task, there’s no escape from others: emails, phone calls and knocks at the door. If you have a microphone then Windows Vista can help you keep track of things with a little-known tool: Sticky Notes. Type Sticky in the Start menu search box, then click the Sticky Notes link to display a blank note. If the Sticky Notes link doesn’t appear when you do this, click Start, type optionalfeatures and press Enter on your keyboard, then check Tablet PC Optional Components and click OK. The next time you have an idea switch back to the note and click Record to make a voice note.

Tip 8
The Windows Vista Aero interface can slow down old PCs, yet also delivers nice features like Flip 3D. The answer? Create an easy way to toggle Aero on and off when you need it. Run REGEDIT, and go to HKEY_CLASSES_ROOT\Directory\Background\Shell. With Shell highlighted, click Edit > New > Key and call the key Aero Off.

Click on the Aero Off key, select Edit > New > Key and call the key Command. Click Command and enter: rundll32 dwmApi #104 ... as the default value. Return to HKEY_CLASSES_ROOT\Directory\Background\Shell, creating a matching key called Aero On, and a command key below that with the value: rundll32 dwmApi #102 Now right-click the desktop and you’ll have options to turn Aero on or off.

Tip 9
Windows Vista Service Pack 1 delivered many bug fixes but also removed the Search option from many places throughout the system. Click Start, for instance, and you won’t see a Search button any more. Annoyingly, SP1 also got rid of the right-click Search option from folders, drives and ZIP files. To undo this damage, run REGEDIT, and go to HKEY_CLASSES_ROOT\CompressedFolder\shell\find. Look in the right-hand pane for a LegacyDisable key, right-click it and select Delete. Repeat the same procedure at HKEY_CURRENT_USER\Directory\shell\find and HKEY_CURRENT_USER\Drive\shell\find to bring your right-click search options back to normal.

Tip 10
Is Windows set up to deliver its best green results? Click Control Panel > System and Maintenance > Power Options > Very Low Power > Change Plan Settings > Change Advanced Power Settings to find out. If you can see the Processor Power Management, expand it and set your Maximum Processor State to 10 per cent, say, then Windows is working just fine. Select the Very Low Power plan and performance will drop, but you’ll save a lot of energy, ideal for running a PC overnight or boosting laptop battery life. If you don’t see the Processor Power Management option then check your Bios
setup program, make sure Intel Speedstep or AMD Cool and Quiet is enabled, reboot and check the plan again.

**Tip 11**
You can change the Start Menu so that it displays more recent programs in its list every time you click on it, rather than just a handful of recently used applications. First, right-click on the Start button and select Properties. In the dialogue box that appears, click on the Customize button. This will bring up the Customize Start Menu dialogue box. Scroll down the list of options until you get to the last one and remove the tick next to where it says ‘use large icons’. Now, just underneath, type a higher number into the box next to where it says ‘Number of recent programs to display’ — you can start by increasing it to 18, but it’s possible to come back and change this if it doesn’t suit. Now Click OK > OK to finish.
Our disc is packed with great software. We have listed the main applications below, and over the page you'll find tips on how to get started with the best ones.

### Software listing

#### Full Software
- TuneUp Utilities 2007
- PC Tools Desktop Maestro 2
- PC Tools Spyware Doctor 6 Starter
- Paragon Drive Backup Express 9
- Titan Backup 1.5
- Ashampoo WinOptimizer 2009

#### Backup, File & Drive Copy
- Cobian Backup 9.1.1.193
- DriveImage XML 2.01
- File Hamster 1.5.2.5
- O&O DiskImage 3 Express
- ShadowExplorer 0.4
- TeraCopy 2.0 Beta

#### File & System Management
- Directory Opus 9.1.1
- FreeCommander 2008.06b
- LaunCy 2.1.2
- Start++ 0.8.1
- Switcher 2.0.0
- Total Commander 7.04a

#### General System Tools
- BurnAware Home v2.1
- Copernic Desktop Search 2.3
- Desktops 1.0
- Dexpot 1.4
- EditPad Lite 6.4.3
- MediaPortal 1.0
- Mozilla Firefox 3.01
- Mozilla Thunderbird 2.0.0.16
- OpenOffice 3.0
- Paint.NET 3.36
- VirtuaWin 4.0.1
- VLC Media Player 0.8.6i

#### Home Media Servers
- EyeConnect 1.5.3
- Fuppes
- myiHome 5.0.2
- MythTV 0.21
- TVersity 1.0.0.3
- TwonkyMedia 4.4.6

#### Optimisation & Tweaking Tools
- Fresh UI 8.14
- TuneUp Utilities 2008
- TweakVI Basic 1.0.1085
- TweakVista 1.1
- Vista Shortcut Manager
- WindowBlinds 6.2

#### Security
- Avast! Home 4.8.1229
- AVG Anti-Virus Free 8.0.138
- Avira AntiVir Personal 8.2.0.334
- Comodo Firewall Pro 3.0.25.378
- Eraser 5.86
- Keepass 2.05
- Microsoft Virtual PC 2007
- PC Tools Firewall Plus 4
- Sandboxie 3.3
- ScrubIT
- SecuniaPSI
- TrueCrypt 6

#### System Update Tools
- DriverMax 4.4
- FileHippo Update Checker v1.023
- SUMO 2.3.1.57
- UpdateStar 2.2.614
- vLite 1.2
Paragon Drive Backup 9.0 Express

Keep all your most important files safe from harm with this reliable image backup tool

A good tweaking session can revitalise your PC and have it running at peak performance. But there’s a potential down side, too. Make a mistake, delete the wrong Registry setting or disable an important Windows service and you can create all kinds of problems. In extreme cases you might even be left with a PC that will no longer start up at all, so it pays to prepare for the worst. And there’s no better way to do that than with an disk image tool like Paragon Drive Backup 9.0 Express.

The program couldn’t be much simpler to use. Click ‘Back up disk or partition’ to launch the Simple Backup Wizard, choose the drive you want to back up, a spare drive where your data will be stored, and that’s it. Paragon Drive Backup 9.0 Express will go to work creating an exact copy of everything on your hard disk. Now click Build Recovery Media and follow the instructions to create a bootable CD, DVD or USB memory key. If the worst happens and your PC won’t get going, start from this device instead and it will launch a special version of Paragon Drive Backup 9.0 Express. Use this to restore your data and the PC will soon be running as normal.

System requirements: Windows 2000/XP/Vista, 100MB free hard disk space

Contact: www.paragon-software.com

Need to know: Upgrade to Paragon Drive Backup 9.0 Personal and you’ll be able to exclude some files and folders from your image, speeding up the backup process. A scheduler allows backups to run automatically, and you’ve even more ways to restore them in an emergency. The program normally costs around Rs.1,577 but as a registered owner of the Express version you qualify for a 20 per cent discount. Check your registration email for more details.

PC Tools Desktop Maestro 2

A powerful scanning engine to clean up your Registry and boost computer performance

Install most applications and they’ll create a number of sections in the Registry to hold their settings. But if you uninstall that application later the chances are that some of those Registry sections will be left behind. And so over time the Registry just keeps getting larger, eventually slowing down your PC.

PC Tools Desktop Maestro tackles this problem with a powerful Registry scanning engine. Launch the program, click Start Scan and it goes to work, checking all the key areas of your Registry for leftover entries. After a minute or so you’ll see a report detailing the problems it’s uncovered, and you can then clean up everything by clicking the Repair button. Once the process has finished you’re able to compact the Registry, removing any gaps to make it even more efficient. But that’s not all. PC Tools Desktop Maestro also includes useful privacy tools, a disk defrag scheduler, and an ingenious set of Registry tweaks and patches that are designed to improve your PC’s performance. It’s a must-have for anyone keen on getting the most out of their computer.

System requirements: Windows 98/Me/2000/XP/Vista, 10MB hard disk space
PC Tools Spyware Doctor 6 Starter Edition

Keep your computer spyware-free with one of the best malware detectors on the market

Windows Defender is a welcome addition to Vista’s security tools, but it’s a good idea to install a specialist anti-spyware tool ready to deliver a second opinion and PC Tools Spyware Doctor is one of the best.

The first plus point you’ll notice is the program’s speedy scanning engine. Some anti-spyware tools take an hour or more to trawl through your hard disk, but PC Tools Spyware Doctor can check the most commonly infected areas in around five minutes. The results of the scan are categorised according to their severity: low, medium or high. Each threat is colour-coded, too, which means you can see at a glance whether there’s anything to worry about. And whatever the program has uncovered can then be deleted with a single click.

Spyware scans are useful, but of course can only pick up spyware after it has infected your PC. So it’s good to see that PC Tools Spyware Doctor 6 Starter Edition also includes a real-time protection system called IntelliGuard.

Need to know: The latest version of Desktop Maestro includes new tools to manage your Windows services, control startup programs and uninstall applications. A one-year subscription will cost only Rs.2,194, a 20 per cent saving on the usual price, and you’ll find more details on this (and discounts for other PC tools applications) at www.pctools.com/en/desktop-maestro/free/promo/VNU0908/

Contact: www.pctools.com

System requirements: Windows 2000/XP/Vista, 60MB hard disk space

Contact: www.pctools.com

Need to know: Upgrade to the full version of Spyware Doctor and you’ll get much improved real-time protection with guards to monitor your browser and network settings, startup programs, running processes and more. Prices are Rs.2,124 for a 12-month Spyware Doctor licence, or Rs.2,832 for Spyware Doctor with a full anti-virus engine, and the program is licensed to protect up to three PCs. Visit www.pctools.com to find out more.

Titan Backup 1.5

Freedom to choose whether to back up emails, program settings or your entire hard disk

Windows Vista comes with a simple file backup tool, but this offers very little control. There’s an option to back up all the images on your hard disk, for instance, but no way to be more selective.

You can’t choose to back up everything in your Pictures folder, for instance, even though that’s precisely the kind of function that people really need.

Install Titan Backup 1.5 and you won’t have to worry about that kind of limitation any more. It can back up files by category, just like the Windows tool, so it’s easy to save all your video or music. But the program also lets you back up the Registry, your email, application settings, or whatever files and folders you’d like, just by checking a few boxes.

Your backup files can be compressed to improve performance, encrypted to prevent anyone else from reading confidential files.
or saved as self-extracting archives, so you can restore them even if Titan Backup isn’t installed. The files may then be saved to local or network drives, CDs, DVDs, removable devices like memory cards or USB memory keys, even a remote FTP server if you have access to one. And you don’t even have to remember to run regular back-ups, as the very capable scheduler will sort that out for you automatically.

**System requirements:** Windows 2000/XP/Vista, 8MB free disk space

**Contact:** www.titanbackup.com

**Need to know:** Enter the key 000020-ACM8KK-1Y3VMT-JZT4CH-YZEY5T-70PFlK-XAHHCV-UHFCFW to register the program.

The latest version of Titan Backup adds support for backing up the settings of many more applications, including Firefox, Opera, Adobe Photoshop, Dreamweaver and more. It can also back up files that are in use when the backup is running, and can encrypt your data to keep it safe from snoopers. It costs only Rs.530 and you can find out more at www.titanbackup.com/special-offers/vnunet.html.

## TuneUp Utilities 2007

A one-stop maintenance toolkit to make light work of optimising your computer

With TuneUp Utilities 2007 you can change the way the desktop works, control Windows startup programs, clean up your hard disk and the Registry, or try more than 100 different ways to improve your computer performance. Read more about this in our workshop on page 66.

The real value of the suite comes in its bundled tools, though. Have you ever wondered why your hard disk is whirring away even when you’re not doing anything, for example? Launch the TuneUp Process Manager, click the Open Files tab and you’ll see a list of all the files currently being accessed on your hard disk, and the program examining them.

The TuneUp Registry Editor is another highlight. It looks a lot like Windows own Registry Editor, but includes many useful improvements. A History pane lists all the keys you’ve accessed, for instance, so it’s easy to return to a key you were viewing earlier.

**System requirements:** Windows 98/Me/2000/XP/Vista, 50MB hard disk space

**Contact:** www.tuneup-software.co.uk

**Need to know:** Use your name and the serial code TNGAR-GFAHB-GSEQE-JUPLG-RSSUB-EQAHY when registering the program. The TuneUp Utilities 2008 upgrade includes a drive defragger to optimise hard disk performance, and a TuneUp Repair Wizard that can fix many common PC problems in a couple of clicks, as well as revamped interface that makes the program even easier to use. The normal price is Rs.2,124, but you can upgrade for only Rs.1275. Find out more at www.tuneup-software.co.uk/products/tuneup-utilities/news

## Ashampoo WinOptimizer 2009

Literally hundreds of ways to easily clean, tune and tweak your tired old PC back to life

**Ashampoo WinOptimizer 2009** provides hundreds of ways to clean, tune and tweak your PC. And while other tweaking tools can be tricky to navigate, this one has a clean and simple interface that makes it easy to find the functions you need.
Is your PC drowning in leftover clutter, for instance? Click Modules > Clean up system and you’ll find links to delete unnecessary files, fix Registry problems, or clear your browser cache file, history and cookies.

Is speed the problem? Choose the Optimize Performance module, defragment your hard disk, take control of your startup programs or disable unnecessary services.

And if you don’t think Windows is set up correctly, then look no further than the Tune system settings module. It’s packed with tweaks for Control Panel, Explorer, Windows Media Player, Microsoft Office, Outlook, Firefox and more.

If you prefer an easier life, then select the Overview tab and click Full Scan. WinOptimizer 2009 will examine your PC’s configuration and report on any problems, then you can fix them all in one go just by clicking the Start Optimization button.

**System requirements:** Windows 2000/XP/Vista, 40MB hard disk space

**Contact:** www.ashampoo.com

**Need to know:** Leave ‘Get full version key’ checked during installation to register the program. Upgrade to Ashampoo WinOptimizer 5 and you’ll gain a file undelete tool, real-time backup program and Registry Optimizer, while all the cleanup tools can now be launched from a Windows Vista Sidebar Gadget. The list price is Rs.2,125, but as a registered user you can upgrade for only Rs.530. Click Internet > Upgrade to order.

**vLite 1.2**

Free up memory and computer resources by creating a custom version of Windows Vista

Windows Vista requires lots of memory and computer resources to run properly, and so often performs poorly on older PCs or notebooks. One reason for this is the operating system now comes with so many applets, components and services that less powerful computers just can’t cope, but there is a possible solution. vLite 1.2 creates a custom Windows Vista installation DVD that removes all the components you don’t need, so reducing memory requirements and improving your PC speed.

Do you never use applets like Paint, for instance? If not, get rid of them. You don’t have an Xbox, a Windows Mobile device, a TV tuner? If not, and you’re sure you won’t buy them in future, then there’s no need to keep the hardware support. And Windows Vista also comes with plenty of components that you’ll probably never miss. If you’ve installed your own backup tool and firewall, for instance, then do you really need Windows own versions? vLite can remove those, too.

The results can be impressive, freeing up lots of Ram and delivering much better PC speeds, but there’s also a price. You must reinstall Vista to see any benefit (vLite can’t work with the current installation), and if you remove something you need later then another reinstall will be necessary.

**System requirements:** Windows Vista, 7MB hard disk space

**Contact:** www.vlite.net

**Need to know:** Check the busy vLite forum for help and advice on using the program (www.vlite.net)

**Desktops 1.0**

Four virtual desktops allow you to organise numerous open applications more efficiently

If you’re running four or five programs on the Windows Vista desktop then it’s easy to switch between them. Just click an application window, use Flip3D or select a button on the taskbar. But what if you need to run 10 programs, 15, maybe 20? Now the taskbar buttons are too small to read, Flip3D is a mess, and even Alt+Tab won’t quickly get you to the application you need.
Launch Desktops and you’ll discover a simple and elegant solution: three new desktops. If you’ve launched too many tools on your main desktop, say, launch the Desktops program as well, and when you see its system tray icon (four blue squares) press Alt+2. A second blank desktop will open, with just your desktop wallpaper, task bar and Start menu. You can then launch new programs here, just as normal. Press Alt+3 and Alt+4 to open additional desktops as required, or Alt+1 if you need to switch back to your original desktop. Alternatively, just click the Desktops system tray icon to see preview windows of your four desktops, select the one you need, and Desktops will switch to it immediately. It’s a clever tool that really can boost your PC productivity, but keep in mind there’s no way to delete a desktop object and so you can’t close the program. If you want to exit Desktops, then log off or reboot.

**System requirements:** Windows Vista, 1MB disk space

**Contact:** www.tinyurl.com/5fywm3

**Need to know:** Desktops is a Microsoft Sysinternals program. Check www.tinyurl.com/5fywm3 regularly for more information and the latest updates.

**FreeCommander 2008.06b**

This easy-to-use Explorer replacement saves time and avoids file management hassles

If you’re not happy with the Windows Vista Explorer then you could try tweaking it, choosing new window layouts and other options to see if they’ll improve matters. But you’ll probably get much better results by using another file manager altogether, such as FreeCommander.

The dual-pane layout makes it much easier to copy files, for instance. Just open one folder in the left-hand pane, another in the right, then drag and drop your files across. A tabbed interface means it’s extremely quick to switch between drives. If you want to explore the DVD in drive D, perhaps, there’s no scrolling through Computer – you just click the D icon on the toolbar.

The program comes with some very useful file selection options. If you want to select all the JPEG images in a folder using Explorer, say, then you usually have to hold down Ctrl and click each one in turn. With FreeCommander all you do is choose one, click Edit > Select Files with the same extension, and the program will select all the others for you. You also get a powerful file viewer, built-in archive handling (ZIP, RAR and CAB formats), an easy way to rename multiple files in a single step, and much more. Give it a try – you’ll be surprised just how much time you can save.

**System requirements:** Windows 2000/XP/Vista, 5MB hard disk space

**Contact:** www.freecommander.com

**Need to know:** The authors also provide a free file viewer, editor, and other tools to use with FreeCommander. Find out more at www.freecommander.com/fc_utilities_en.htm.

**O&O DiskImage 3 Express Edition**

Create an exact backup copy of your hard disk without worrying about tricky settings

The Windows Vista Business, Enterprise and Ultimate editions come with a Complete PC Backup and Restore tool that makes it easy to back up your entire hard disk. Windows Vista Home Basic and Home Premium users don’t get this, unfortunately, but
there’s no need to feel left out — you can add similar capabilities to your PC with a copy of O&O DiskImage 3 Express Edition.

The program is very easy to use. A single toolbar offers two main backup-related options: create a backup image, and restore a backup image. Choose the Create button, point O&O DiskImage 3 Express Edition to the spare drive where you’d like the backup image to be saved, and that’s it. There are no complicated options to worry about, or tricky settings to consider — the program just immediately goes to work creating a backup copy of your hard disk.

Restoring your backups is just as straightforward, but beware. The Express Edition of O&O DiskImage 3 can back up your system partition, but isn’t able to restore it (you’ll need the Professional Edition for that, see ‘Need to know’ below).

If you only have one partition then the program won’t be useful, and you should use one of the other backup tools on our cover disc instead.

System requirements: Windows 2000 Pro/XP/Vista

Contact: www.oo-software.com

Need to know: O&O DiskImage 3 Express Edition cannot restore system partitions (the partition you boot from). To do that (and gain other handy bonus features) you’ll need a copy of O&O DiskImage 3 Professional, which is available for only Rs.1,415 from www.oo-software.com.